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Preface

The SPSS® 12.0 Brief Guide provides a set of tutorials designed to acquaint you with
the various components of the SPSS system. You can work through the tutorials

in sequence or turn to the topics for which you need additional information. You

can use this book as a supplement to the online tutorial that is included with the
SPSS Base 12.0 system or ignore the online tutorial and start with the tutorias
found here.

SPSS 12.0

SPSS 12.0 is a comprehensive system for analyzing data. SPSS can take data from
almost any type of file and use them to generate tabulated reports, charts, and plots of
distributions and trends, descriptive statistics, and complex statistical analyses.

SPSS makes statistical analysis more accessible for the beginner and more
convenient for the experienced user. Simple menus and dialog box selections make
it possible to perform complex analyses without typing a single line of command
syntax. The Data Editor offers a simple and efficient spreadsheet-like facility for
entering data and browsing the working data file.

Internet Resources

The SPSS Web site (http://mww.spss.com) offers answers to frequently asked
guestions about installing and running SPSS software and provides access to data
files and other useful information.
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In addition, the SPSS USENET discussion group (not sponsored by SPSS)
is open to anyone interested in SPSS products. The USENET address is
comp.soft-sys.stat.spss. It deals with computer, statistical, and other operational
issues related to SPSS software.

You can a'so subscribe to an e-mail message list that is gatewayed to the USENET
group. To subscribe, send an e-mail message to listserv@listserv.uga.edu. The text of
the e-mail message should be: subscribe SPSSX-L firstname lastname. You can then
post messages to the list by sending an e-mail message to listserv@listserv.uga.edu.

Additional Publications

For additional information about the features and operations of SPSS Base 12.0,
you can consult the SPSS Base 12.0 User’s Guide, which includes information on
standard graphics. Complete information about using interactive graphics can be
found in SPSS Interactive Graphics 10.0, which is compatible with release 12.0
of SPSS. Examples using the statistical procedures found in SPSS Base 12.0 are
provided in the Help system, installed with the software. Algorithms used in the
statistical procedures are available on the product CD-ROM.

In addition, beneath the menus and dialog boxes, SPSS uses a command |anguage.
Some extended features of the system can be accessed only via command syntax.
(Those features are not available in the Student Version.) Complete command
syntax is documented in the SPSS 12.0 Command Syntax Reference, provided on
the product CD-ROM.

Individuals worldwide can order additional product manuals directly from SPSS
Inc. For telephone orders in the United States and Canada, call SPSS Inc. at
800-543-2185. For telephone orders outside of North America, contact your local
office, listed on the SPSS Web site at http://mww.spss.com/worldwide.

The SPSS Satistical Procedures Companion, by MarijaNorusis, is being prepared
for publication by Prentice Hall. It contains overviews of the procedures in the SPSS
Base, plus Logistic Regression, General Linear Models, and Linear Mixed Models.
Further information will be available on the SPSS Web site at http://mww.spss.com
(click store, select your country, and click Books).



SPSS Options

The following options are available as add-on enhancements to the full (not Student
Version) SPSS Base system:

SPSS Regression Models™ provides techniques for analyzing data that do not fit
traditional linear statistical models. It includes procedures for probit analysis, logistic
regression, weight estimation, two-stage | east-squares regression, and genera
nonlinear regression.

SPSS Advanced Models™ focuses on techniques often used in sophisticated
experimental and biomedical research. It includes procedures for general linear
models (GLM), linear mixed models, variance components analysis, loglinear
analysis, ordinal regression, actuaria life tables, Kaplan-Meier survival anaysis,
and basic and extended Cox regression.

SPSS Tables™ creates a variety of presentation-quality tabular reports, including
complex stub-and-banner tables and displays of multiple response data.

SPSS Trends™ performs comprehensive forecasting and time series analyses with
multiple curve-fitting models, smoothing models, and methods for estimating
autoregressive functions.

SPSS Categories® performs optimal scaling procedures, including correspondence
analysis.

SPSS Conjoint™ performs conjoint anaysis.

SPSS CHAID™ simplifies tabular analysis of categorical data, develops predictive

models, screens out extraneous predictor variables, and produces easy-to-read tree
diagrams that segment a popul ation into subgroups that share similar characteristics.

SPSS Exact Tests™ calculates exact p values for statistical tests when small or very
unevenly distributed samples could make the usual tests inaccurate.

SPSS Missing Value Analysis™ describes patterns of missing data, estimates means
and other statistics, and imputes values for missing observations.

SPSS Maps™ turns your geographically distributed data into high-quality maps with
symbols, colors, bar charts, pie charts, and combinations of themes to present not
only what is happening but where it is happening.



SPSS Complex Samples™ allows survey, market, health, and public opinion
researchers, as well as socia scientists who use sample survey methodology, to
incorporate their complex sample designs into data analysis.

The SPSS family of products also includes applications for data entry, text analysis,
classification, neural networks, and flowcharting.

Training Seminars

SPSS Inc. provides both public and onsite training seminars for SPSS. All seminars
feature hands-on workshops. SPSS seminars will be offered in major U.S. and
European cities on aregular basis. For more information on these seminars, contact
your local office, listed on the SPSS Web site at http://mww.spss.com/wor [dwide.

Technical Support

The services of SPSS Technical Support are available to registered customers of
SPSS. (Student Version customers should read the special section on technical support
for the Student Version. For more information, see “Technical Support for Students”
on page viii.) Customers may contact Technical Support for assistance in using SPSS
products or for installation help for one of the supported hardware environments. To
reach Technica Support, see the SPSS Web site at http://mwww.spss.com, or contact
your locd office, listed on the SPSS Web site at http: //www.spss.com/worldwide. Be
prepared to identify yourself, your organization, and the serial number of your system.

Tell Us Your Thoughts

Your comments are important. Please let us know about your experiences with SPSS
products. We especially like to hear about new and interesting applications using
the SPSS system. Please send e-mail to suggest@spss.com, or write to SPSS Inc.,
Attn: Director of Product Planning, 233 South Wacker Drive, 11th Floor, Chicago IL
60606-6412.

SPSS 12.0 for Windows Student Version

The SPSS 12.0 for Windows Student Version is alimited but still powerful version
of the SPSS Base 12.0 system.
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Capability

The Student Version contains al of the important data analysis tools contained in
the full SPSS Base system, including:

Spreadsheet-like Data Editor for entering, modifying, and viewing datafiles.

Statistical procedures, including t tests, analysis of variance, crosstabulations,
and multidimensional scaling.

Interactive graphics that allow you to change or add chart elements and variables
dynamically; the changes appear as soon as they are specified.

Standard high-resolution graphics for an extensive array of analytical and
presentation charts and tables.

Limitations

Created for classroom instruction, the Student Version is limited to use by students
and instructors for educational purposes only. The Student Version does not contain
all of the functions of the SPSS Base 12.0 system. The following limitations apply to
the SPSS 12.0 for Windows Student Version:

Data files cannot contain more than 50 variables.

Data files cannot contain more than 1500 cases. SPSS add-on modules (such

as Regression Models or Advanced Models) cannot be used with the Student
Version.

SPSS command syntax is not available to the user. This means that it is not
possible to repeat an analysis by saving a series of commands in a syntax or “job”
file, as can be done in the full version of SPSS.

Scripting and automation are not available to the user. This means that you
cannot create scripts that automate tasks that you repeat often, as can be done
in the full version of SPSS.
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Technical Support for Students

Students should obtain technical support from their instructors or from local support
staff identified by their instructors. Technical support from SPSS for the SPSS 12.0
Student Version is provided only to instructors using the system for classroom
instruction.

Before seeking assistance from your instructor, please write down the information
described below. Without this information, your instructor may be unable to assist
you:

m  Thetypeof PC you are using, as well as the amount of RAM and free disk
space you have.

The operating system of your PC.

A clear description of what happened and what you were doing when the problem
occurred. If possible, please try to reproduce the problem with one of the sample
data files provided with the program.

m  Theexact wording of any error or warning messages that appeared on your screen.
m  How you tried to solve the problem on your own.

Technical Support for Instructors

Instructors using the Student Version for classroom instruction may contact SPSS
Technical Support for assistance. In the United States and Canada, call SPSS
Technical Support at 312-651-3410, or send an e-mail to support@spss.com. Please
include your name, title, and academic institution.

Instructors outside of the United States and Canada should contact your local SPSS
office, listed on the SPSS Web site at http://www.spss.com/wor|dwide.
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Chapter

Introduction

This guide provides a set of tutorials designed to acquaint you with the various
components of the SPSS system. You can work through the tutorials in sequence or
turn to the topics for which you need additional information. The goal isto enable
you to perform useful analyses on your data with SPSS.

This chapter will introduce you to the basic environment of SPSS and demonstrate
atypical session. We will run SPSS, retrieve a previously defined SPSS data file,
and then produce a simple statistical summary and a chart. In the process, you will
learn the roles of the primary windows within SPSS and see a few features that
smooth the way when running analyses.

More detailed instruction about many of the topics touched upon in this chapter
will follow in later chapters. Here, we hope to give you a basic framework for
understanding and using SPSS.

Sample Files

Most of the examples presented here use the data file demo.sav. This datafileis
afictitious survey of several thousand people, containing basic demographic and
consumer information.

All sample files used in these examples are located in the folder in which SPSSis
installed or in the tutorial\sample_files folder within the SPSS installation folder.
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Starting SPSS

>

To start SPSS:

From the Windows Start menu choose:

Programs
SPSS for Windows
SPSS for Windows

To start SPSS for Windows Student Version:

From the Windows Start menu choose:

Programs
SPSS for Windows Student Version

When you start a session, you see the Data Editor window.

Figure 1-1
Data Editor window (Data View)
Drata Editor |- O] x|
File  Edit “iew Data Transform  Analize Graphs  Utilities  Window  Help
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Variable Display in Dialog Boxes

Either variable names or longer variable labels will appear in list boxesin dialog
boxes. Additionally, variablesin list boxes can be ordered alphabetically or by their
position in the file.

In this guide, we will display variable labelsin aphabetical order within list boxes.
For a new user of SPSS, this provides a more complete description of variablesin
an easy-to-follow order.

Since the default setting within SPSSisto display variable labelsin file order, we
will change this before accessing data.

» From the menus choose;

Edit
Options...

» Select Display labels in the Variable Lists group on the General tab.
» Also select Alphabetical.

» Click Ok, and then click OK to confirm the change.

Opening a Data File
Before you can analyze data, you heed some data to analyze.

To open a datafile:

» From the menus choose:
File
Open
Data...
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Alternatively, you can use the Open File button on the toolbar.

Figure 1-2
Open File toolbar button

ul

L=~

This opens the Open File dialog box.

Figure 1-3
Open File dialog box

Open File nn
Lok, it I@ zample_filez j a £k B3~

P o - e

bankloan.saw CElamics. 53y cross_sell zav E
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baskethall zav cereal say idermo. av E
o= = ) ”

brakes. zaw clothing_defects. zaw dietztudy. zaw E
o= . = =

callwaitsay contacts.zay dizchargedata. zav E
& cars. sav credit_card.zav dvdplayer sav B
o= = . L

cellular zav creditpromo. zay esatisf. sav E

1 3

File name: Idemo.sav Open

Files of type: ISPSS [*zav) LI ﬂl
Cancel |
A

By default, SPSS-format data files (.sav extension) are displayed. You can display
other file formats using the Files of Type drop-down list.

By default, data files in the folder (directory) in which SPSSisinstalled are
displayed. The filesfor this guide are located in the folder in which SPSSisinstalled
or in the tutorial\sample_files folder within the SPSS installation fol der.

» Double-click the tutorial folder.

» Double-click the sample files folder.
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» Click thefile demo.sav in thefiles list box (or just demo if file extensions are not
displayed).

Figure 1-4
Sample_files folder displayed in Open File dialog box
Open File ﬂ m
Laak i I 5 sample_files j & |=_°i< ER-~
bankloan. sa CEIAMICE. $8v B cross_sell sav E
bashethall zaw cereal.zav E
brakes.sav clothing_defects. sav ietstudy. zav E
callwait.zay contacts.zay dizchargedata. zav E
cars. sav credit_card.zav dvdplayer. zav E
cellular zav creditpromo. ay esatisf. sav E
1 3
File name: Idemo.sav Open
Files of bype: ISPSS [* zaw) LI Paste |
Caticel |
p

» Click Open to open the SPSS data file.

Figure 1-5
Variable labels
Data Editor [_ (O] x|
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1 37 = 35.00 2.00 1i
2 33 1 12 29.00 200 1
3 42 1 21 34.00 2.00 1
4 a8 0 28 49.00 200 3
5 a6 0 9 57.00 3.00 1
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The datafileis displayed in the Data Editor. If you put the mouse cursor on avariable
name (the column headings), a more descriptive variable label is displayed if one has
been defined for that variable.

By default, the actual data values are displayed. To display labels:

From the menus choose;
View
Value Labels

Alternatively, you can use the Label tool on the toolbar.

Figure 1-6
Value Labels tool

%

Descriptive value labels are now displayed. This makes it easier to interpret the
responses.
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Figure 1-7
Value labels displayed in the Data Editor
Data Editor H=1 E1
File Edit “iew Data Transform  Analyze Graphs  Ubliies ‘window  Help
(@[S | o] | D] k| a) Ee SlnE [ 2l
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3 421 Married 21 34.00| %2500 15
4 58 | Unmarried 28 49.00| $25 00 3z
5 56 | Unrnarried 9 57.00| 50,00 1¢
53 46 [Unmarried 5 39.00| §25 00 1E
7 471 Married 4 56.00| $50,00 2E
g 62| Married 16 250,000 %7500 7
o £ haeriad 7 7300 %50 nn b
[ |\Data View £ Variable View I 1? | v,

Running an Analysis

The Analyze menu contains a list of general reporting and statistical analysis
categories. Most of the categories are followed by an arrow, which indicates that there
are severa analysis procedures available within the category; they will appear on a
submenu when the category is selected.

We'll start with a simple frequency table (table of counts).

» From the menus choose;

Analyze
Descriptive Statistics
Frequencies...



8

Chapter 1

This opens the Frequencies dialog box.

Figure 1-8

Frequencies dialog box

Y ariable(s): ik |

@ Call waiting [zallva
& CallerID [calid] _Faste |
A Gender [gender] Feset |
® Has newspaper sul c I
G Household income ﬂl
& Income category [i Help |
® Internet [intermet]
A mnl _J..__L:_._;I

¥ Display frequency tables

Statistics... | Chartz... | Format... |

» Select (click) the variable Income category.

Figure 1-9
Variable labels and names in the Frequencies dialog box

Wariable[z]: oK |

@ Call waiting [callwa =
& Caller 1D [calid] _la“’ &
|3'< Gender [gender] Reset |
@ Has newspaper sul -n
#» Household income ﬂl
® Income category [inccat] | Help |
& Internet [intemet]
At ot _J..__L:_._LI

¥ Display frequency tables

Statistics. . | Charts... | Format... |

A more complete description of each variable pops up when the cursor is over it. The
variable name (in square brackets) is inccat, and it has the variable label Income
category. If there were no variable label, only the variable name would appear in
the list box.
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In the dialog box, you choose the variables you want to analyze from the source list
on the left and move them into the Variable(s) list on the right. The OK button, which
runs the analysis, is disabled until at least one variable is placed in the Variable(s) list.

Additional labeling information can be easily obtained for any variable on the list
by clicking on the variable name with the right mouse button.

» Click the right mouse button on Income Category [inccat], and then click (left
mouse button) Variable Information.

» Click the down arrow on the Value Labels drop-down list.

Figure 1-10

Defined labels for income variable
< Age in vears [age] |~ Wi (], |
<@ Call waiting [callwa
@ Caller ID [calic] &I
@ Gender [gender] Reset |
< Has mewspaper sul
4 Household income ﬂl
@ Income categony (i Hein |
@ Internet [intermet] Income category
T I '} .4.....:...ﬂ

. MHame: i £
¥ Display frequency tables AMe: NEES

Measurerent: Ordinal

Walue labels: [1.00 Under $25,000

00 Under $25,000

00 $25,000 to $43.939
3.00 $50.000 to $74,999
4.00 $75.000 or mare

All of the defined value labels for the variable are displayed.

» Click Gender [gender] in the source variable list, and then click the right-arrow
button to move the variable into the target Variable(s) list.
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» Click Income category [inccat] in the source list, and then click the right arrow
button again.

Figure 1-11
Variables selected for analysis

® e in pears [age] |~ Yariable(z):
G Call waiting [calwa (8% Gender [gende] )

& Caller 1D [calid] @ Incame categor [inces ﬂl
& Has mewspaper sul Feset |
& Household income c I
4 Internet finteret] ﬂl
& Level of education Help |
& Warital status [marit

R b e o r_...m:;l

¥ Display frequency tables

Statistics... | Chartz... | Format... |

A pound sign (#) icon next to the variable name indicates that the variableis numeric.
Anicon with the letter “A” indicates that the variable is a string (a phanumeric)
variable, which may contain both letters and numbers. A less-than sign (left angle
bracket) indicates that the variable is a short string, containing eight or fewer
characters.

» Click OK to run the procedure.
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Viewing Results
Figure 1-12
Viewer window
% Dutput] - SPSS Viewer [_ (O] x|
Fil= Edit “iew Inzett Faormat Analyze Graphs  Utiities  WwWindow  Help
s(@(a|n| »l = | O] of &
Ctput :I
Log
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=l e Frequencies
Motes
- Statistics
H El Frequency T: Statistics
=] Title |
@ Gender ncome.
category in
@ Income o (encer thouzands
M alic E400 E400
Mis=ing u] u]
Frequency Table
| v« | M 4

Results are displayed in the Viewer window.

Introduction

You can quickly go to any item in the Viewer simply by selecting it in the outline pane.

» Click Income category.
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Figure 1-13
Frequency table of income categories

% Dutput] - SPSS Viewer [_ (O] x|

Fil= Edit “iew Inzett Faormat Analyze Graphs  Utiities  WwWindow  Help
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- Statistics
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Frecquency Percert “alid Percent Percent
Walid  Uncler $23 1174 183 183 183
325 - 349 23588 373 373 257
a0 - §74 1120 175 175 732
F75+ 1718 268 268 1000
Total E400 100.0 100.0
-
4 | 2Kl | H

This takes you directly to the frequency table for income categories. This frequency
table shows the number and percentage of people in each income category.

Creating Charts

Although some statistical procedures can create high-resolution charts, you can also
use the Graphs menu to create charts.

For example, you could create a chart that shows the rel ationship between wireless
telephone service and PDA (personal digital assistant) ownership.

» From the menus choose:

Graphs
Bar...

» Click Clustered and then click Define.
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Figure 1-14
Define Clustered Bar dialog box

: Define Clustered Bar: Summaries for Groups of Cases

— Bars Reprezent
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@ Houzehold income | I ﬂl
@ Incame categary in Chatme Surarmar... | Help |
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il

» Scroll down the source variable list and select Wireless service [wireless] as the
Category Axis variable.

» Select Owns PDA [ownpda] as the Define Clusters By variable.

» Click OK to create the chart.
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Figure 1-15
Bar chart displayed in Viewer window

% Dutput] - SPSS Viewer [_ (O] x|

Fil= Edit “iew Inzett Faormat Analyze Graphs  Utiities  WwWindow  Help

s(as(R B =] - H=z] | &

%‘f”“ 4000 =
Log

Frequencies
Title
Motes 3000
- Statistics
- {E] Frequency T
2000
i L Gender >
E@ \ncome o Cwens POA,
Log 1000
fE] sraph WMo
- [ Title
[ Motes 0 | | mes
Mo fes

Count
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-
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The bar chart is displayed in the Viewer. It shows that people with wireless phone
service are far more likely to have PDAs than people without wireless service.
You can edit charts and tables by double-clicking on them in the contents pane of

the Viewer window, and you can copy and paste your results into other applications.
Those topics will be covered later.

Exiting SPSS

To exit SPSS:
» From the menus choose:

File
Exit

» Click No if you get an aert asking if you want to save your results.
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Using the Help System

Help is available in a number of different ways, including:

Help menu. Every window has a Help menu on the menu bar. The Topics menu item
provides access to the Help system, where you can use the Contents and Index tabs to
find topics. The Tutorial menu item provides access to the introductory tutorial.

Dialog box Help buttons. Most dialog boxes have a Help button that takes you directly
to aHelp topic for that dialog box. The Help topic provides general information and
links to related topics.

Pivot table context menu Help. Right-click on termsin an activated pivot table in
the Viewer and select What's This? from the context menu to display definitions
of the terms.

Statistics Coach. The Statistics Coach item on the Help menu provides a wizard-like
method for finding the right statistical or charting procedure for what you want to do.

Case Studies. The Case Studies item on the Help menu provides hands-on examples
of how to create various types of statistical analyses and interpret the results. The
sample data files used in the examples are also provided so that you can work through
the examples to see exactly how the results were produced.

This chapter uses the files demo.sav and bhel ptut.spo.

15
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Help Contents Tab

The Topics item on the Help menu opens a Help window.

» From the menus choose;

Help
Topics

Figure 2-1

Help Contents tab

E? Base System !Elm
G =2 9 A

Hide Back Fomward Stop  Refresh Home

LContents ||D'2|E?'= |

Overview

= [} Base Syste ;I
L 30 verview _ SPSS for Windows provides a powerful
@ Getting Help statistical analysis and data management
@ DataFiles system in a graphical environment, using
@ Winual Active File descriptive menus and simple dialog boxzes
@ Data Editor to do most of the work for you. Most tasks
@ Copp Data Froperties can be accomplished simply by pointing and
@ Define Variable Prope clicking the mouse,

@ Data Transformations
@ File Handiing and File
@ Restructuring Data
@ Working with Output
@ Draft Viewesr

@ Fivat Tables . ) r
@ ‘Working with Comma Data Editor. & versatile spreadsheet-like

@ Fiequencies system for defining, entering, editing, and
v

‘ | | R displaying data.
J |

In addition to the simple point-and-click
interface for statistical analysis, SPSS for
Windows provides:

The Contents tab in the left pane of the Help window is an expandable and collapsible
table of contents. It is most useful if you're looking for general information or are
unsure of what index term to use to find what you're looking for.
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Help Index Tab

Figure 2-2

Help Index tab

E? Base System !Elm
G =2 9 A

Hide Back Fomward Stop  Refresh Home

Contents  |ndex I Overview

Type in the keyword ba find:

|| SPSS for Windows provides a powerful

statistical analysis and data management
M system in a graphical environment, using
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command syntax to do most of the work for you. Most tasks
30 mtatiﬂlﬂ can be accomplished simply by pointing and
scatterplots il
3D scatterplats clicking the mouse,
case labels
case weights In addition to the simple point-and-click
sfmtlm' vdaglaltsles interface for statistical analysis, SPSS for
izplayed data : P .
rotating Windows provides:
zpikes

wirefame | Data Editor. & versatile spreadsheet-like
Access (Micosoft] system for defining, entering, editing, and

Dizplay | displaying data.

|

» Click the Index tab in the left pane of the Help window.

The Index tab provides a searchable index that makes it easy to find specific topics.
The Index tab is organized in aphabetical order, just like a book index. It uses
incremental search to find what you're looking for.

For example, you can:

» Type med.
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Figure 2-3
Incremental index search

i? Base Spstem !EIE
G =2 @ fa}
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Jmed SPSS for Windows provides a powerful
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i R atio Statistics =
in Summarize In addition to the simple point-and-click
"“'?d'_‘l?” te|3td ot Samnies Test interface for statistical analysis, SPSS far
In | wo-lndependent-aamples | esiz : . R
ey Windows provides:
Increasing vir_tual memory
memary allacation ) E Data Editor. & versatile spreadsheet-like
it TwoSten Cluzster Snalvsis

system for defining, entering, editing, and

Display | displaying data.

[ |

The index scrolls to and highlights the first index entry that starts with these letters,
which is median.

Dialog Box Help

Most dialog boxes have a Help button that displays a Help topic about what the
dialog box does and how to do it.

» From the menus choose:

Analyze
Descriptive Statistics
Frequencies...

» Click Help.
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Figure 2-4

Dialog box Help topic

i? Base System [_ (O] x|
G =2 @ fa}

Hide Back Forward Stop  Refresh  Home

|

Contents ||ﬂdBH |

= [} Base System ;I

Frequencies

@ Overview J The Freguencies procedure provides statistics
@ Getting Help and graphical displays that are useful for

@ DataFiles describing many types of variables, For a first
@ Vitual Active File look at wour data, the Frequencies procedure is
@ Data Editor a good place to start,

@ Copy Data Prope

@ Define Variable F For & frequency report and bar chart, you can
e Data Transformal arrange the distinct values in ascending or

e F"'EHa”d"_”g ang descending order or order the categories by

b4 Restiucturing Da their frequencies. The frequencies report can be
e werking with Oul suppressed when a variable has many distinct
@ Diaft Viewer values. ¥ou can label charts with frequencies

4 Pivet Tables (the default) or percentages.
@ Wworking with Cor

= (0 Frequencies Example. What is the distribution of a

2F " company's customers by industry type? From
euencies | the output, you might learn that 37.5% of your

@ How to Obtail+ - : .

- customers are in government agencies, 24.9% in
LI _I b corporations, 28.1% in academic institutions, ;I

In this example, the Help topic describes the purpose of the Frequencies procedure
and provides an example.

Statistics Coach

The Statistics Coach can help to guide you through the process of finding the
procedure that you want to use.

» From the menus choose:

Help
Statistics Coach
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Figure 2-5
Statistics Coach, first step

What do you want to do?
Industry
Government §2.525 |§1.252.641
Commercial | $2,481 |§1,280,304 ' Summarize, describe, or present data
$2.546 51,211,724
BL517 |$3744.860 Lotk atvariance and distribution of data
Cumulative
Percent € Create OLAP report cubes
=1 Minute 186
1-2 Minutes 424
4 Mnes (2 € Compare groups for slgnificant diferences
= 4 Minutes 1000
Total
Iin”::;m : ‘.:gm“
< 1 Minute
1-2 Minutes © Identity groups of similar cases

-4 Minutes
= 4 Minutes:

" Identify groups of similar variables

| sk o] _coc |

The Statistics Coach presents a series of questions designed to find the appropriate
procedure. The first question is simply “What do you want to do?’

For example, if you want to summarize data:
» Select Summarize, describe, or present data.

» Then click Next.



21

Using the Help System

Figure 2-6
Data type selection

‘What kind of data do you want to
summarize?

@ Data In categonies (nominal, ordinal)

" Continuous, numeric data (interval, ratio)

© Confinuous, numeric variables within calegories

C Multiphe response data

Medium

] oo ] _owes |

The next question asks about the type of data you want to summarize. If you're
unsure, each choice displays different examples.

» Select Continuous, numeric data (interval, ratio).
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Figure 2-7
Selecting a different data type

‘What kind of data do you want to
summarize?
" Data In categanies (nominal, ordinal)

& | Continuous, numeric data (interva, ratio)

 Confinuous, numeric variables within calegories

C Multiphe response data

155 ] e [oesel]

The example changes to reflect your choice. If you're still unsure, you can:

» Click More Examples.
A new example of the same data type is displayed. If the examples don't provide
enough information, you can:

» Click Help.
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Figure 2-8
Statistics Coach Help topic

<=8 Help - Microsolt Internet Explorer !E[E
-

Data Types

Categorical data are data with a limited number
of distinct values or categories {for example,
gender ar religion). Also referred to as
gualitative data. Categorical wariables can bhe
string {alphanumeric) data or numeric variables
that use a numeric codes to represent
categories for exarmple, 0= Female and 1=
Male).

Mominal data are categorical data where there
is no inherent order to the categories. For
example, a job category of "sales" isn't higher or
loweer than a job category of "marketing” or
"research”

Ordinal data are categorical data where there is =
a meaningful arder of categories, butthere isnt

a measurable distance betiween categories, For
example, there is an order to the values high,
rrediurm, and lowe, but the "distance" between

the values can't be calculated.

In this example, the Help topic defines the different data types.
» Close the Help window.

» Select Data in categories (nominal, ordinal) and click Next.
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» Select Tables and numbers and click Next.

Figure 2-9
Selecting tables or charts

What kind of display do you want?

& Tables and numbers

" Charls and graphs

Marilal Slatus Walid Percent
Married Jz0
Widawed Mo
Divorcad 14.2

Separated L 27
Hewar maried 181
Taotal 1000

More Examples Help | Back | Newt| Cancel |
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» Select Individual case listings within categories.

Using the Help System

Figure 2-10
Statistics Coach, final step

E? Statistics Coach
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Managar
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More Examples

Help | Back | Finish | Cancel |

When the Statistics Coach has enough information, the Next button changes to Finish.
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When you click Finish, the dialog box for the selected procedure opens
automatically, and a Help topic for the procedure is also displayed.

Figure 2-1
Dialog box and Help topic

: Summarize Cases

‘Wanablas:

b Age in years [ags]
3 How To - Microsoft Internet Explorer Hﬁu

To Obtain Individual Case Listings in

L

Categories Cancel
From the menus choose; Help
Anatyze blefs}
Reports

Case Summarigs..
Selecl one or rmore variables

Selecta categorical grouping variahla that divide
your data into subgroups.

The categorical grouping variable can be a ki

shing (alphanumeric) variable or a numeric M
variable that use numeric codes o represent
categones (e.g, 0=Male, 1=Famals).

Tell me mare... I

Thisis acustom Help topic, based on your selectionsin the Statistics Coach. Since
some dialog boxes perform numerous functions, more than one path in the Statistics
Coach may lead to the same dialog box, but the instructions in the Help topic may
be different.

» Click Tell me more in the Help topic to get more detailed information.
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Figure 2-12
“Tell me more” Help topic
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This Help topic provides detailed information on the data type(s) appropriate for
the selected procedure.

Case Studies

Case studies provide comprehensive overviews of each procedure. Data files used
in the examples are installed with SPSS, so you can follow along, performing the
same analysis—from opening the data source and selecting variables for analysis to
interpreting the results.

To access the case studies:

» Right-click on any pivot table created by a procedure. For example, you can
right-click on the frequency table for Gender.
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Figure 2-13
Accessing the case studies

i Yiewer !El B
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» Select Case Studies on the pop-up context menu.

Case studies are not available for al procedures. The Case Studies choice on the
context menu will appear only if the feature is available for the procedure that created
the selected pivot table.
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Chapter

3

Data can be entered directly into SPSS, or it can be imported from a number
of different sources. The processes for reading data stored in SPSS data files,
spreadsheet applications like Microsoft Excel, database applications like Microsoft
Access, and text files are al discussed in this chapter.

Basic Structure of an SPSS Data File

Figure 3-1
Data Editor

Drata Editor
File Edit “iew Data Transform  Analyze  Graphs

Utilities  \wWindow  Help

= E

=|0|S] B o|] L] x| b] ] Fles] ElEE @
|13 : age |33
age marital address income inccat cs_‘l
1 37 1 12 35.00 200 1
2 33 1 12 2800 2.00
3 42 1 21 34.00 2.00
4 els] 1] 28 48.00 200
] a6 o ] 47.00 3.00
] 45 o 5 39.00 200
7 47 1 4 56.00 3.00
g 62 1 16 250,00 4.00
TlTI\gata\ﬁew f:fariable Wiew } |« TT | i R v[

SPSS datafiles are organized by cases (rows) and variables (columns). In this data
file, cases represent individual respondents to a survey. Variables represent each

question asked in the survey.

29
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Reading an SPSS Data File

SPSS data files, which have a .sav file extension, contain your saved data. To open
demo.sav, an example file that is installed with the product:

» From the menus choose:
File
Open
Data...

» Make sure SPSS (*.sav) is selected in the Files of Type drop-down list.

Figure 3-2
Open File dialog box

Open File nn
Lok jr; I@ sample_files j = =5 B3~

Fil name:  |demo.sav Open

Files of upe: ISF‘SS [* zav] ;I Paste

Cancel

i

» Navigate to the sample_files folder.

» Select demo.sav and click Open.
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The data are now displayed in the Data Editor.

Figure 3-3

Opened data file
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Reading Data from Spreadsheets

Reading Data

Rather than typing all of your data directly into the Data Editor, you can read data
from applications like Microsoft Excel. You can also read column headings as
variable names.

» From the menus choose:

File
Open
Data...
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» Select Excel (*.xIs) from the Files of Type drop-down list.

Figure 3-4
Open File dialog box
Open File nm
Lack jri | ‘3 sample._files =] 4= £ B~
dema, ol
File name: Idemo,:-;ls Open
Files of upe: IEHCB| [*.xls) ;I Paste

Cancel

i

Z

» Select demo.xls and click Open to read this spreadsheet.

The Opening Excel Data Source dialog box is displayed, allowing you to specify
whether variable names are to be included in the spreadsheet, as well as the cells that
you want to import. In Excel 5 or later, you can also specify which worksheets

you want to import.

Figure 3-5
Opening Excel Data Source dialog box

C:AProgram Files\SPS Shtutarialhsample_filezdemo. =ls

v ‘Fead vanable names from the first row of data;

worksheet: [demo [41:4B6401] |

Range: I

ok I Cancel Help |
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» Make sure Read variable names from first row of data is selected. This option reads
column headings as variable names.

If the column headings do not conform to the SPSS variable-naming rules, they are
converted into valid variable names and the original column headings are saved as
variable labels. If you want to import only a portion of the spreadsheet, specify the
range of cellsto be imported in the Range field.

» Click OK to read the Excdl file.

The data now appear in the Data Editor, with the column headings used as variable
names. If you're using a spreadsheet application other than Excel or Lotus, you should
be able to export your data to a supported format that can then be read into SPSS.

Figure 3-6
Imported Excel data
Data Editor =1 3
File  Edit “iew Data Transform  Analize Graphs  Utilities  Window  Help
=|8|8| = || L] =5 6l ] DR S 2
|1 : age |55
age marital address income incecat car ;I
1 55 1 12 72.00 3.00 37.00
2 56 ] 29 153.00 4.00 76.00
3 28 1 9 28.00 200 13.80
4 24 1 4 26.00 200 13.00
5 25 1 2 23.00 1.00 11.30
] 45 0 9 76.00 4.00 37.30
7 44 1 17 144.00 4.00 7210
g 45 1 20 75.00 4.00 37.10
4 41 0 10 26.00 200 13.00
10 28 0 4 19.00 1.00 .60
1 34 0 0 89.00 4.00 44.40
12 55 0 17 72.00 3.00 36.10
13 28 0 9 55.00 3.00 28.20
14 1 1 2 20.00 1.00 9.60 2
TlTI‘;Elata\ﬂew ;{{fariahle View f EE b T P
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Reading Data from a Database

» Select MS Access Database from the list of data sources and click Next.

From the menus choose:
File

Open Database
New Query...

Figure 3-7
Database Wizard Welcome dialog box

D atabaze Wizard [ x|

Welcome To the Database Wizard!

Thig waizard will help pou select the data elements pou wizh bo work, with during your SPSS sezsion.

Select Data Source:

Data from database sources are easily imported using the Database Wizard. Any
database that uses ODBC (Open Database Connectivity) drivers can be read directly
by SPSS after the drivers are installed. ODBC drivers for many database formats are
supplied on the installation CD. Additiona drivers can be obtained from third-party
vendors. One of the most common database applications, Microsoft Access, is
discussed in this example.

From which data sourcels] would you like to retieve data?

B33 dBASE Files

% dBase Files - Word
R ECDCMusic

% Excel Filles

% FoxPro Files - Word
. k5 2 :x Databaze
% Yisual FosPro Database
% Vizual FoxPro Tables

il 2
Add Data Source... |
< Back I Mest > I Cancel | Help
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If MS Access Database is hot listed here, you need to run Microsoft Data Access
Pack.exe, which can be found in the Microsoft Data Access Pack folder on the CD.

Figure 3-8
ODBC Driver Login dialog box

ODBC Driver Login [ x|

Data Source: MS Access Database

IC:\Program FileghSPS Shtutorial sample_files'd

Database

Ok, | Cancel

» Click Browse to navigate to the Access database file you want to open.

Figure 3-9
Open File dialog box
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File name: |demo.mdb Open

Files of type: [l fles (] | Cancel |

[T Open as read-only

= mEEEEE

4

» Select demo.mdb and click Open to continue.

» Click ok in the login didog box.
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In Step 2, you can specify the tables and variables you want to import.

Figure 3-10
Select Data dialog box

Databaze Wizard - Step 2 of b [ x|

Select Data

Mow you need to select the fields you wish to work with. To select items, click on an item in the 'available’ list and, with
the mouze button pressed, drag it over to the 'Retrieve Figlds' list.

Hint: Dragging a table selects all of its fields.

Lvallable Tables:

BRetrieve Fields In This Order:

E-En - B demo: ID -
..... g igEHESS %demo: AGE
----- demo: MARITAL
----- % g&iﬂm 2 demc: ADDRESS
----- & demo: INCOME
----- B CeR B_ demo: INCCAT
""" % E-EHEAT %demo: CaR
---- B demo: CARCAT
..... % Emifg‘:} l%,chamo: ED
_____ & Genoen & demo: EMPLOY
..... s 8 demo: RETIRE _Iﬂ
----- B NCCAT = | -

[+ Sort field names
< Back I Mest » | Finizh | Cancel | Help

» Drag the entire demo table to the Retrieve Fields in This Order list.

>

Click Next.
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In Step 4, you select which records (cases) to import.

Figure 3-1
Limit Retrieved Cases dialog box

Limit Retrieved Cases

Limit the cases that are retieved by specifying one or more criteria.

Hint: Fields and Functions can be added to an expression by dragging and dropping into an expression cell

Criteria:
Connector Expression 1 Relation Expression -
1
2
3
4
5
5 -
Functiohz 1 | | 3
ASCl(strespr) ﬂ -
CHARsscicade] I Use Random 5ampling
CONCAT [strexpr,strexp | Wative random sampling % SPSS random sampling
LEFT [strespr.count]
LTRIM[ztrexpr] % Lpprodimate]y |1 1] _|::‘ % of ol zases
LEMGTHlstrexpr] LI I— I—
 Enactly 100 zases from the first [1000pages
Frampt Far Value . | _

< Back I Mest » I Finizh | Cancel | Help |

If you do not want to import all cases, you can import a subset of cases (for
example, males older than 30), or you can import a random sample of cases from
the data source. For large data sources, you may want to limit the number of cases

to asmall, representative sample to reduce the processing time. The default isto
retrieve all cases.

» Click Next to continue.
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Field names are used to create variable names. If necessary, the names are converted
to valid variable names. The origina field names are preserved as variable labels.
You can aso change the variable names before importing the database.

Figure 3-12
Define Variables dialog box

Databasze Wizard - Step b of b m

Define Variables

Enter or edit variable names for the fizlds being retrieved from the data source.
To conwvert an alphabetic wariable to numeric uzing the original values as walue labelz, check Value Labels baow.

Mote: If you do not supply variable names for the fields being retieved, the resulting variable names may be supplied for
you [e.g. warl07).

IRBsuIt Variable Hame|Data Type| Value Labels| ﬂ
dema: ID I Mumeric
dema; AGE AGE Mumeric
demo: MARITAL |MARITAL Mumeric
demao: ADDRESS | ADDRESS Mumeric
dema: INCOME INCOME Mumeric
demno: INCCAT IMCCAT Mumeric
demo: CAR CAR Mumeric
demao; CARCAT  |CARCAT Mumeric
dema: EDr ED Mumeric
demo: EMPLOY  |EMPLOY Mumeric
demo: RETIRE RETIRE Mumeric
demao; EMPCAT  |EMPCAT Mumeric
demo. GEMDER | GEMDER Alphabetic |
remn RESINE RESINFE Bl mErie LI

< Back I Mest > I Finizh | Cancel | Help |

» Click the Value Labels cell in the Gender field. This option converts string variablesto
integer variables and retains the original value as the value label for the new variable.

» Click Next to continue.
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The SQL statement created from your selectionsin the Database Wizard appearsin the
Results dialog box. This statement can be executed now or saved to afile for later use.

Figure 3-13
Results dialog box

Results

Your selection has resulted in the following SAL quen:

SELECT "TO°ID*AS ID°, "TOAGE™ AS "AGE", "TO""MARITAL® A5 "MARITAL", "TOADDRESS® AS ;I
ADDRESST, "TOVIMCOME™ AS "INCOME", "TOVINCCAT™ AS (IMCCAT™, "TO"CAR™AS TAR,

TOUCARCAT AS CARCAT, "TOVED™AS EDC, "TOEMPLOY™ &5 'EMPLOY, "TORETIRE™AS "RETIRE",
TOEMPCAT® A5 "EMPCAT™, "TOGEMDER™ A5 "GENDER', "TO"'RESIDE" &5 "RESIDE".

T WIRELESS® AS "WIRELESS®, "TO"'MULTLIME® A5 "WMULTLINE", "TO%OICE® AS “OICE",
TOPAGER™ A5 "PAGER, "TOVINTERMET A5 INTERMET", "TOCALLID™ A5 TALLID™, "TO" CaLlwalT"

A5 TALLWAIT, "TOUOWHNTY A5 OWNTY, "TOT OWHNWCR™ &5 "OWHNWCR', "TOOWNCD &5

TWNCDT, "TOOWHNPDA™ A5 OWNPDA", "TOOWNPC A5 "TWwWHPCT, "TO" " OWNFAR A5 "DWwhNFAR",
TOUWEWS™ A5 'MEWS™, "TOW'RESPONSE™ A5 "RESPONSE™ FROM "C:\Program Files\SPS SN tutorialvsample
files\dema”. "dema’ "TO

-

—What would pou like to do with this quen?

&' Retieve the data | have selected. ¥ Cache the data locally.

" Paste it into the syntax editor for further modification

— Save query ta file

I Browse |

< Back | Mest > | Finizh I Cancel | Help |

» Click Finish to import the data.
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All of the datain the Access database that you selected to import are now availablein

the SPSS Data Editor.
Figure 3-14
Data imported from an Access database
Data Editor | _ (O] x]
File  Edit “iew Data Transform  Analize Graphs  Utilities  Window  Help
=S| B o] L] =] sl Fe| BlEE[S @
|1 : age |55
age marital address income incecat car ;I
1 55 1 12 72.00 3.00 37.00
2 a6 0 29 153.00 4.00 76.00
3 28 1 9 28.00 2.00 13.90
4 24 1 4 26.00 2.00 13.00
5 25 1 2 23.00 1.00 11.20
53 45 0 9 76.00 4.00 37.30
7 44 1 17 144.00 4.00 72.10
g 46 1 20 75.00 4.00 37.10
9 41 0 10 26.00 2.00 13.00
10 29 0 4 19.00 1.00 9.60
11 34 0 0 89.00 4.00 44.40
12 a5 0 17 72.00 3.00 36.10
13 28 0 9 5500 3.00 26820
14 M 1 2 20.00 1.00 9.60 2
TlTI‘;Elata\ﬂew ;{{fariahle View f EE b T P

Reading Data from a Text File

Text files are another common source of data. Many spreadsheet programs and
databases can save their contents in one of many text file formats. Comma or
tab-delimited files refer to rows of data that use commas or tabs to indicate each
variable. In this example, the data are tab delimited.

» From the menus choose:
File
Read Text Data...
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» Choose Text (*.txt) from the Files of Type list.

Figure 3-15
Open File dialog box

Open File

Lok jr; I@ sample_files j = =5 B3~

File name: Idemo.txt Open

Files of tupe: |Text [* k=) | Paste

i

[T Open as read-only Cancel

Z

» Select demo.txt and click Open to read the selected file.
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The Text Import Wizard guides you through the process of defining how the specified
text file should be interpreted.

Figure 3-16
Text Import Wizard - Step 1 of 6

Text Import Wizard - Step 1 of 6 n

ij “Welcome o the test import wizard!
i 11
|.~ 3 Thiz wizard will help you read data from your test file and
FARTOGOLILAT it i i :
oAl T s 41 01 - zpecify information about the wariables.
A ;
e T [T Does wour text file match a predefined format?
1  Yes Brawse.. |
] i
- i
]
af ] 3
r— Text file: ]
u] 10 ZID : SID 40 50

IWGEOMARITALOADDREIZOINCOMEO INCCATOCAROCARCATOEDOENPLO| &
5501012072 .0003 . 00037, 0003 . 000102300030£0500010101000
IFe000250153 . 0004 . 0007 6. 0003 . 000103 500030:x010100010100
ES010250z28. 0002 .00013 .9001 . 00030400010£030000000000000 LI

B | 2

< Back I Mest » I Eirzh | Cancel | Help |

» In Step 1, you can choose a predefined format or create a new format in the wizard.
Select No to indicate that a new format should be created.

» Click Next to continue.
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As stated earlier, thisfile uses tab-delimited formatting. Also, the variable names

are defined on the top line of thisfile.

Figure 3-17
Text Import Wizard - Step 2 of 6

Text Import Wizard - Step 2 of 6 n

—How are your vanables aranged?
& Delimited - Yariables are delimited by a specific character [i.e.. comma, tab).

€ Fixed width - Yariables are aligned in fised width columns.

— &re vanable names included at the top of wour file?
& ires
Mo

r— Text file:
u] 10 ZP . SP 40 50

IWGEOMARITALOADDREIZOINCOMEDO INCCATOCAROCARCATOEDOEMPLO
5501012072 . 0003 . 00037. 0003 . 000102300030£0500010101000
IFe000250153 . 0004 . 0007 6. 0003 . 000103 5000301x010100010100
ES010250z28. 0002 .00013 .9001 . 00030400010£030000000000000

-]

A 2

< Back I Mest » I Firnzh | Cancel | Help

» Select Delimited to indicate that the data uses a delimited formatting structure.

» Select Yes to indicate that variable names should be read from the top of thefile.

>

Click Next to continue.
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» Type 2 in the top section of next dialog box to indicate that the first row of data
starts on the second line of the text file.

Figure 3-18
Text Import Wizard - Step 3 of 6

Text Import Wizard - Delimited Step 3 of 6 n

The first cagze of data begins on which line number? IE 3:

—How are your cazes represented?

&' Each line represents a case

" A specific number of wariables represents a case; |1 3:

—How many cazes do you want to import?
& Al of the cases

" The first |1 0oo cases.

" & random percentage of the cases [approsimate]; |1D 3: 4

—Data preview

u} 10 20
[ I

1 1 1 1 3ID 1 qID 1 5ID
15501012072 .0003.00037. 0003 . DDEI1I:I23|:|DEI3EIfEI5EIDEI1EI1EI1E;I
156000290153 .0004.000%78.0003.000103500030w010100010Y
801059028 .000z2.00013.9001 . 000304000 lEIfI:IQEIEIEIDEIEIEIDEIDELI

< o]
< Back I Mest » I Firnzh | Cancel | Help |

» Keep the default valuesfor the remainder of this dialog box and click Next to continue.
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The Data preview in Step 4 provides you with a quick way to ensure that your data
are being properly read by SPSS.

Figure 3-19
Text Import Wizard - Step 4 of 6

Which delimiters appear between variables? Wwhat is the text qualifier?

¥ Tab [" Space & Hone

" Single guote
[~ Comma [~ Semicolon
" Double quote

" Other: I—  Oter I—

[iata preview
Lk | v2 V3 v w5 V6 1 3
AGE MARITAL ADDRESS INCOME INCCAT CAR CARC
25 1 12 7200 3.00 37.00 3.00
56 ] 29 153.00 4.00 FE.00 3.00
28 1 g 25.00 200 13.90 1.00 vI
d | A

< Back | Mest » | Firnzh | Cancel |

» Select Tab and deselect the other options.

» Click Next to continue.
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Because the variable names may have been truncated to fit SPSS formatting
requirements, this dialog box gives you the opportunity to edit any undesirable names.

Figure 3-20
Text Import Wizard - Step 5 of 6
Text Import Wizard - Step 5 of 6 n
— Specifications for wanable(s) selected in the data previe
Wanable name;
Data format:
IDD Mat Irmpart ﬂ
—Data preview
AGE MARITAL ADDRESS IHCOME IHCCAT CAR Cﬂﬂ
55 1 12 7200 3.00 37.00 3.00
56 o 29 153.00 4.00 ¥E.00 3.00
25 1 9 25.00 2.00 13.90 1.00
24 1 4 26.00 2.00 13.00 100 =
4 I I 3

< Back I Mest » I Firnzh | Cancel | Help |

Data types can be defined here as well. For example, it's safe to assume that the
income variable is meant to contain a certain dollar amount.

To change a data type:

» Under Data preview, select the variable you want to change, which is Incomein
this case.
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» Select Dollar from the Data format drop-down list.

Figure 3-21
Change the data type

Text Import Wizard - Step 5 of 6 n

Data format;

— Specifications for vanable(z] selected in the data previe

Wanable name; Original Mame:

IINCDME INCOME

MHurneric

Lo Jled

—Data preview
AGE MARITAL ADDRESS IHCOME IHCCAT CAR Cﬂﬂ
25 1 12 37.00 3.00
56 ] 29 FE.00 3.00
25 1 9 13.90 1.00
24 1 4 13.00 100 *
4 I I 3
< Back I Mest » I Firnzh Cancel | Help

» Click Next to continue.

Reading Data
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Figure 3-22
Text Import Wizard - Step 6 of 6

Text Import Wizard - Step 6 of 6 n

You have successfully defined the format of your text file.

Would wou like to zave this file farmat far future uze?

" Yes I ﬁave.f-‘-.s...l

“Would pou like to paste the zyntax?
 Yes ¥ Cache data locally

FNQ

Prezs the Finizh button to complete the test import wizard.

— Data preview
AGE MARITAL ADDRESS IHCOME IHCCAT CAR C;ﬂ
B 1 12 F2.00 3.00 37.00 3.0
56 0 29 153.00 4.00 7E.00 .00
28 1 ] 25.00 2.00 13.90 1.00
24 1 4 26.00 2.00 13.00 1.00_F
4 I | »

< Back | et | Finizh I Cancel | Help |

» Leave the default selections in this dialog box, and click Finish to import the data.

Saving Data

To save an SPSS data file, the Data Editor window must be the active window.
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From the menus choose:

File
Save

Browse to the desired directory.

Type aname for the file in the File name text box.

The Variables button can be used to select which variables in the Data Editor are
saved to the SPSS data file. By default, all variables in the Data Editor are retained.

Click save.

The namein thetitle bar of the Data Editor will change to the filename you specified.
This confirms that the file has been successfully saved as an SPSS data file. Thefile

contains both variable information (names, type, and, if provided, labels and missing

value codes), and all data values.
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Using the Data Editor

The Data Editor displays the contents of the active data file. The information in the
Data Editor consists of variables and cases.

m In Data View, columns represent variables and rows represent cases
(observations).

m |n Variable View, each row is a variable, and each column is an attribute
associated with that variable.

Variables are used to represent the different types of data that you have compiled. A
common analogy is that of a survey. The response to each question on a survey is
equivalent to avariable. Variables come in many different types, including numbers,
strings, currency, and dates.

Entering Numeric Data

Data can be entered into the Data Editor, which may be useful for small datafiles or
for making minor edits to larger data files.

» Click the Vvariable View tab at the bottom of the Data Editor window.

Define the variables that are going to be used. In this case, only three variables are
needed: age, marital status, and income.

51
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Figure 4-1
Variable names in Variable View
Data Editor | _ (O] x]
Eile Edit “iew Data Transform  Analyze  Graphs  Utilities  Window  Help
SRS B o] D w[k] &l £l ElRETT @
Mame Type Width Decimals Label Yalus 2
1|age Mumeric 8 2 Mone
2| rnarital Mumeric g 2 Mone
3lincome MNurmeric 8 2 MNone
4
5
&
¥
B
&
10
11
12
13
14
15
16 hd
+ [ ¥ [\ Data Wiew } Variable View / 4] | bl

» Inthefirst row of the first column, type age.
» In the second row, type marital.

» In the third row, type income.
New variables are automatically given a numeric data type.

If you don't enter variable names, unique names are automatically created. However,
these names are not descriptive and are not recommended for large datafiles.

» Click the Data View tab to continue entering the data.

The names that you entered in Variable View are now the headings for the first three
columnsin Data View.
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Begin entering data in the first row, starting at the first column.

Figure 4-2

Values entered in Data View

Using the Data Editor

Data Editor !EIE
File Edit “iew Data Transform  &nalpze Graphs  Utliies Window  Help
S| |8| B v|| D] =k ol £l BlEE 2
|34: |
age marital income WAt war war 2

1 55.00 1.00 72000.00

2 53.00 00| 153000.00

3

4

5

&)

7

&}

g

10

11

12

13

14 =
TlTI‘;['_)ata\ﬁew;(VariahleViewf || | v

In the age column, type 55.

In the marital column, type 1.

In the income column, type 72000.

Move the cursor to the first column of the second row to add the next subject's data.

In the age column, type 53.

In the marital column, type 0.

In the income column, type 153000.
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Currently, the age and marital columns display decimal points, even though their
values are intended to be integers. To hide the decimal pointsin these variables:

» Click the variable View tab at the bottom of the Data Editor window.
» Select the Decimals column in the age row and type 0 to hide the decimal.

» Select the Decimals column in the marital row and type O to hide the decimal.

Figure 4-3
Updated decimal property for age and marital
Drata Editor | _ O] x]
File  Edit “iew Data Transform  Analyze  Graphs  Utilites  Window  Help
=R|8| 8| o] L) =|k| A el ElEE v 2
Marne Type Width | Decimals Label Yalus 2
1|age Mumeric 8 0 Mone
2| marital Mumeric 8 0 Mone
3|income Mumeric g 2 Mone
i
5
]
7
g
g
10
11
7]
13
14
15
16 X
« [ ¥ [\ Data Wiew h Variable View / 4] | o[
Entering String Data

Non-numeric data, such as strings of text, can aso be entered into the Data Editor.
» Click the variable View tab at the bottom of the Data Editor window.

» Inthefirst cell of the first empty row, type sex for the variable name.
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» Click the Type cell.

» Click the button in the Type cell to open the Variable Type dialog box.

Figure 4-4
Button shown in Type cell for sex
D ata Editor | _ (O] x]
Eile Edit “iew Data Transform  Analyze  Graphs  Utilities  Window  Help
2|=|8| B| o|| D] =|k] il £l E|EE[V @

Mame Type Width Decimals Label o
1]age Mumeric 8 0 {
2| marital Murneric g 0 {
3|income MNumeric g 0 i
4| sex Mumeric |8 0 i
5
G
7
g
4

10

11

12

13

14

15

16 x
+ [ ¥ [\ Data Wiew } Variable View / 4] | b

» Select String to specify the variable type.
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» Click OK to save your changes and return to the Data Editor.

Figure 4-5
Variable Type dialog box

Variable Type HE

" Humeic oK
" Comma
" Dot

" Scientific notation Characters: IS_ Help
" Date

" Dollar

€ Custom curency

~

Cancel

Bl

Defining Data

In addition to defining data types, you can al so define descriptive variable and value
labels for variable names and data values. These descriptive labels are used in
statistical reports and charts.

Adding a Variable Label

Labels are meant to provide descriptions of variables. These descriptions are often
longer versions of variable names. Labels can be up to 256 characters long. These
labels are used in your output to identify the different variables.

Click the variable View tab at the bottom of the Data Editor window.
In the Label column of the age row, type Respondent's Age.

In the Label column of the marital row, type Marital Status.

vV v v Y

In the Label column of the income row, type Household Income.
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» Inthe Label column of the sex row, type Gender.

Figure 4-6
Variable labels entered in Variable View
D ata Editor | _ (O] x|
Eile Edit “iew Data Transform  Analyze  Graphs  Utilities  Window  Help
| |8| B| v|| O] =|k| & £l BlEET 2l
Mame Type Width Decimals Label =
1|age Mumeric 8 0 Respondent's Age i
2| rnarital Mumeric g 0 Marital Status i
3lincome MNurmeric 8 2 Household Incorme i
4|=ex String 8 0 Gender i
5
&
¥
B
&
10
11
12
13
14
15
16 X
+ [ ¥ [\ Data Wiew } Variable View / 4] | b

Changing Variable Type and Format

The Type column displays the current data type for each variable. The most common
are numeric and string, but many other formats are supported. In the current data
file, the income variable is defined as a numeric type.

» Click the Type cell for the income row, and then click the button to open the Variable
Type dialog box.



58

Chapter 4

» Select Dollar in the Variable Type dialog box.

Figure 4-7

Variable Type dialog box

Variable Type HE
& Lgets $H 0 = =
" Lomma it 2 I_I
-~ St e Carcal |

et | i

£ Scientific notation _m¢ o Help |
" Date
& Dol ik [z
" Custom cumency Dol Plases ID_
r“' St_rlng ECIimal Flaces:

The formatting options for the currently selected data type are displayed.
» Select the format of this currency. For this example, select St ## 1.

» Click OK to save your changes.

Adding Value Labels for Numeric Variables

Value labels provide a method for mapping your variable values to a string label. In
the case of this example, there are two acceptable values for the marital variable.

A value of 0 means that the subject is single, and a value of 1 means that he or

she is married.

» Click the Values cell for the marital row, and then click the button to open the Value
Labels dialog box.

The value is the actual numeric value.

The value labél isthe string label applied to the specified numeric value.
» Type 0 inthe Vauefied.

» Type Single in the Value Label field.
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» Click Add to add this label to the list.

Figure 4-8
Value Labels dialog box
Value Labels EHEl
—Walue Labels oK |
Walue: I
A= Cancel |
Walue Label: I

Help
Add 0="5ingle" _I
1

"Married"
Lhange |
Bemove |

» Repeat the process, thistime typing 1 in the Value field and Married in the Value
Labdl field.

» Click Add, and then click OK to save your changes and return to the Data Editor.

These labels can also be displayed in Data View, which can help to make your data
more readable.

» Click the Data View tab at the bottom of the Data Editor window.
» From the menus choose:

View
Value Labels

The labels are now displayed in alist when you enter values in the Data Editor. This
has the benefit of suggesting avalid response and providing a more descriptive answer.
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Figure 4-9
Value labels displayed in Data View
Drata Editor !EIE
File Edit Wiew Dats Transform  Analvze  Graphs  Utilites  Window  Help
SRS B o| | L) =|k] @l £l EEET 2
|34: |
age marital income sex war war 2
1 55| Married $72,000
2 53| Single $153,000
3
A4
5
B
7
&
g
10
11
12
13
14 s
[ I‘;['_)ata\ﬁew;(\fariahle View [ || | v[

Adding Value Labels for String Variables

String variables may require value labels as well. For example, your data may use
single letters, M or F, to identify the sex of the subject. Value labels can be used to
specify that M stands for Male and F stands for Female.

» Click the Vvariable View tab at the bottom of the Data Editor window.

» Click the Values cell in the sex row, and then click the button to open the Value
Labels dialog box.

» TypeF inthe Vauefield, and then type Female in the Value Label field.
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» Click Add to add thislabel to your datafile.

Figure 4-10
Value Labels dialog box
Value Labels EHEl
—Walue Labels oK |
Walue: I
A= Cancel |
Walue Label: I
Help |
Add F ="Female"

b ="M ale"
Lhange |

» Repeat the process, this time typing M in the Value field and Male in the Value
Labdl field.

» Click Add, and then click OK to save your changes and return to the Data Editor.

Because string values are case sensitive, you should make sure that you are consistent.
A lowercase mis not the same as an uppercase M.

Using Value Labels for Data Entry

In a previous example, we chose to have value labels displayed rather than the

actual data by selecting value Labels from the View menu. You can use these values
for data entry.

» Click the Data View tab at the bottom of the Data Editor window.

» Inthefirst row, select the cell for sex and select Male from the drop-down list.
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» Inthe second row, select the cell for sex and select Female from the drop-down list.

Figure 4-1

Using variable labels to select values

Data Editor

File  Edit “iew Data Transform  Analwze Graphs

Utilities  Window Help

= |8 B o] L] 2|k & ElE| 2% 2

|2 sex

||':

age

rratital

incorme

Sex

war

war

55

Married

$72,000

Male

53

Single

$153,000

Female =

Male

g B EREN ol B BN e R

i)

10

11

12

13

14

« [ |\Data View £ Variahia View /

[l e

&

Only defined values are listed, which helps to ensure that the data entered arein a
format that you expect.

Handling Missing Data

Missing or invalid data are generally too common to ignore. Survey respondents
may refuse to answer certain questions, may not know the answer, or may answer
in an unexpected format. If you don't take stepsto filter or identify these data, your
analysis may not provide accurate results.
For numeric data, empty data fields or fields containing invalid entries are handled
by converting the fields to system missing, which isidentifiable by a single period.
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Missing values displayed as periods

Using the Data Editor

Data E ditor |- O] x|
File  Edit “iew Data Transform  Analize Graphs  Utilities  Window  Help
=[8|&| ®| o] || =[k] 8] f] SR 2
|18 ;income |
age ratital incarme SEH wal wal =

1 a5 Married 72000 | Male

2 53 Single 5153000 [Female

3 .

4

5

&

¥

B

&

10

11

12

13

14 =
i_lTl‘:Elata\ﬂew;(Variahle View f |l | W

The reason avalue is missing may be important to your analysis. For example, you
may find it useful to distinguish between those who refused to answer a question and
those who didn't answer a question because it was not applicable.

Missing Values for a Numeric Variable

» Click the Vvariable View tab at the bottom of the Data Editor window.

» Click the Missing cell in the age row, and then click the button to open the Missing

Values dialog box.
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In this dialog box, you can specify up to three distinct missing values, or a range of
values plus one additional discrete value.

Figure 4-13
Missing Values dialog box
Mizzing Values EHEl
" No missing values k.

% Discrete missing values

osd | |

Cancel

il

Help
" Range pluz one optional discrete missing walue

Lown I High: I

Digzrete walue; I

» Select Discrete missing values.
» Type999 in thefirst text box and leave the other two empty.

» Click OK to save your changes and return to the Data Editor.

Now that the missing data value has been added, alabel can be applied to that value.

» Click the Values cell in the age row, and then click the button to open the Value
Labels dialog box.

» Type 999 in the Value field.

» Type No Response in the Value Label field.

Figure 4-14
Value Labels dialog box

VYalue Labels EHE

Walue Labels
Walue: 939

Yalug Label (Mo Response

Cancel

Help

4l

Add

Lhange |
Eemove |
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Click Add to add this label to your datafile.

Click OK to save your changes and return to the Data Editor.

Missing Values for a String Variable

Missing values for string variables are handled similarly to those for numeric values.
Unlike numeric values, empty fields in string variables are not designated as system
missing. Rather, they are interpreted as an empty string.

Click the variable View tab at the bottom of the Data Editor window.

Click the Missing cell in the sex row, and then click the button to open the Missing
Values dialog box.

Select Discrete missing values.

Type NR in the first text box.

Missing values for string variables are case sensitive. So, avalue of nr is not treated
as amissing value.

Click OK to save your changes and return to the Data Editor.

Now you can add a label for the missing value.

Click the Values cell in the sex row, and then click the button to open the Value
Labels dialog box.

Type NR in the Value field.
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» Type No Response in the Value Label field.

Figure 4-15
Value Labels dialog box

Value Labels

HE
—Walue Labels oK |
Walue: INF! Cancel |
Walue Label: |No Fesponse
Help
Add I F ="Female" _I
b ="Male"
Lhange |
Bemove |

» Click Add to add thislabel to your project.

» Click OK to save your changes and return to the Data Editor.

Copying and Pasting Value Attributes

Once you've defined variable attributes for a variable, you can copy these attributes
and apply them to other variables.
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» In Variable View, type agewed in thefirst cell of the first empty row.

Figure 4-16
agewed variable in Variable View
Drata Editor !Elm
File Edit “iew [Dats Transform  analyze  Graphs  Utilities  Window  Help
SRS B o|| 0] (k]| &l =l SlRE T 2
MName Type Width Decimals Label A
1|age Murneric g 0 Respondent's Age {
2| marital MNumeric g 0 Marital Status {
3|income Dallar 12 0 Househald Income i
4| zex String g a Gender {
a|agewed MNumeric g 2 Age Married I
B
7
&
o
10
11
1
13
14
15
16 x
< [+ [\ Data view ) Variable View / 4] | _>|_I

» Inthe Label column, type Age Married.

» Click the Values cell in the age row.

» From the menus choose:

Edit
Copy

Edit
Paste

From the menus choose:

Click the Values cell in the agewed row.
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The defined values from the age variable are now applied to the agewed variable.

Figure 4-17
Values pasted for agewed

D ata Editor | _ (O] x]

Eil= Edit “iew Data Trahsform  Analyze Graphs  Utilties  Window  Help

Z|=|S] || o] D] =|k| & 2 Bl vl

Type Width Decimals Label Yalues [

1| Mumeric g 0 Respondent's ({999, Mo Resp (929
2| Mumeric 9 0 Marital Status ({0, Singlel...  |Mone
3| Dollar 12 0 Household Inc |Mone Mane
4| String 8 0 Gender {F, Female}.. |NR
5| Murneric g 2 Age Married  {229.00, No Re|MNane
B

7

g

2
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1

1
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4« [+ [\ Data View » variable View / |4] | v
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To apply the attribute to multiple variables, ssimply select multiple target cells (click
and drag down the column).

Figure 4-18
Multiple cells selected

= 3

Data Editor
Fil= Edit “iew Data Transform  Analize Graphs  Utiltie:  Window  Help

Z|8|3| B| o] | 1] =|k] 6] il BlslE el

18
4 [+ |\ Data View A Variable View / |4] |

Width | Decimals Label “Walues Missing Colu2

118 0 Respondent's {999, No Resp (999 g

219 0 Marital Status ({0, Single}...  [Mone g
3|2 0 Househald Inc [Mone Mone 4

415 ] Gender {F, Female})... |NR g

) 5] 2 Age Married  |{999.00, Mo Re|Mone g

5 I
= I
= I
10
11
1
13
14
15




70

Chapter 4

When you paste the attribute, it is applied to al of the selected cells.

Figure 4-19
Values pasted into multiple cells
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New variables are automatically created if you paste the values into empty rows.

You can also copy all of the attributes from one variable to another.
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» Click the row number in the marital row.

>

Figure 4-20
Selected row

Using the Data Editor
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From the menus choose:

Edit
Copy

» Click the row number of the first empty row.

>

From the menus choose:

Edit
Paste
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All of the attributes of the marital variable are applied to the new variable.

Figure 4-21
Values pasted into row
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Defining Variable Properties for Categorical Variables

For categorical (nominal, ordinal) data, Define Variable Properties can help you
define value labels and other variable properties. Define Variable Properties:

m  Scansthe actua datavalues and lists al unique data values for each selected
variable.

m |dentifies unlabeled values and provides an “auto-label” feature.

m  Provides the ability to copy defined value labels from another variable to the
selected variable or from the selected variable to multiple additional variables.
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This example uses the data file demo.sav. This data file already has defined value
|labels; so before we start, let's enter avalue for which there is no defined value label:

In Data View of the Data Editor, click the first data cell for the variable ownpc (you
may have to scroll to the right) and enter the value 99.

From the menus choose:

Data
Define Variable Properties...

Figure 4-22
Initial Define Variable Properties dialog box
Define Yariable Properties E
Use this facility to label variable values and set other properties after _
zcanhing the data.
Select the variables to scan. They should be categarical [hominal ﬂl
or ordingl] for best results. You can change the measurement level
zetting in the next panel. Help |
Variables: Wanables to Scan;
fﬂall waiting [call... d f Owinz computer [ow...
& Caller D [calid] 47 Dvns fax machine [...
m Gender [gender] f Owinz PDA [ownpdal
& Househald inca.. &7 Dwns steren/CO pla...
|ncome category... [ ] f Oz TV [ovanty]
flnternet [internet] f Ovnz YWCR [ownver]
& Joh satistaction [...
& Level of educati..
fMaritaI shatuz [m...
fh-‘lultiple lines [mu...
Mewspaper subs. ..
& Nowspapersits.. |

™ Limit number of cases scanned to: I

¥ Limit number of values displayed to: 200

Intheinitial Define Variable Properties dialog box, you select the nominal or ordinal
variables for which you want to define value labels and/or other properties.

Since Define Variable Properties relies on actual values in the data file to help you
make good choices, it needs to read the datafile first. This can take sometime if your
data file contains a very large number of cases, so this dialog box also allows you
to limit the number of casesto read, or scan. Limiting the number of casesis not



74

Chapter 4

necessary for our sample datafile. Even though it contains over 6,000 cases, it doesn't
take very long to scan that many cases.

Drag and drop Owns computer [ownpc] through Owns VCR [ownvcr] into the
Variables to Scan list.

You might notice that the measurement level icons for all of the selected variables
indicate that they are scale variables, not categorical variables. By default, all numeric
variables are assigned the scale measurement level, even if the numeric values are
actually just codes that represent categories. All of the selected variablesin this
example are really categorical variables that use the numeric values 0 and 1 to stand
for No and Yes, respectively—and one of the variable properties that we'll change
with Define Variable Properties is the measurement level.

Click continue.

Figure 4-23
Define Variable Properties main dialog box
Define Yariable Properties
S Ve L Cument Warniable: Iownpc Label: IDwns computer
U| M..I " ariable teazurement Level: IScale YI Suggest | Tupe: INumeric LII j
= ﬁ - Unlabeled values: |1— Wficlth: | 4 QEE:"""E'h:lD_
% ? ownp:a Walue Label grid: 0 Enter or edit labels in the grid. “You can enter additional walues at the battom.
owne
@ ﬁ oAty Changed Missing Count Value Label
O & ownver 1 r [ 3588 0|Mo
2 - Il 2511 1|ves
3 I Il 1 a9
4 r r
KN — i
Copy Propertie Unlabeled  alues
Cases scanned: [5400 ’7 From Anather Yariable... | To Other Vanables... | ’7 Automatic Labels |
Yalue list limit: |20 ok I Baste | Beset | Cancel | Help |

» Inthe Scanned Variable List, select ownpc.
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The current level of measurement for the selected variable is scale. You can change
the measurement level by selecting one from the drop-down list or you can let Define
Variable Properties suggest a measurement level.

Click Suggest.

Figure 4-24
Suggest Measurement Level dialog box

Define ¥ariable Properties: Suggest Measurement Level E2

Wariable: Igwnpc
Current Measurement Level: Is.;a|e Cancel
Suggested Level: IDrdinaI or Mominal

" Mominal

Help

ddl

Explanation:  ownpc has only small, nonnegative, integer walues and
does not have a large numer of different walues.

A nominal level is ohe where the variable values do nat have a natural
ranking, for example names of countries.,

An ordinal level is one where the variable values have a natural order
but differences between values are nat meaningful, far example,
importance of a political position coded "low", "medium’’, and "high'".

A zcale level is one where the differences between variable values are
comparable, for example, age in yearz,

The suggested measurement level is based on empinical les and is not
a zubstitute for user judgrent.

SPS5 uses the measurement level in some cases to determine whether
the wariable defines categories in a table or graph or iz bo be summarized.

Since the variable doesn't have very many different values and all of the scanned cases
contain integer values, the proper measurement level is probably ordina or nominal.

Select Ordinal and then click Continue.

The measurement level for the selected variable is now ordinal.

The Value Labels Grid displays al of the unique data values for the selected
variable, any defined value labels for these values, and the number of times (count)
each value occurs in the scanned cases.

The value that we entered, 99, is displayed in the grid. The count isonly 1 because
we changed the value for only one case, and the Label column is empty because we
haven't defined a value label for 99 yet. An X in the first column of the Scanned
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>

>

>

Variable List aso indicates that the selected variable has at |east one observed value
without a defined value |abel.

In the Label column for the value of 99, enter No answer.
Then click (check) the box in the Missing column. Thisidentifies the value 99 as user

missing. Data values specified as user missing are flagged for special treatment and
are excluded from most calculations.

Figure 4-25
New variable properties defined for ownpc
Define Yariable Properties
Soanned Vanable List Cument Warniable: Iownpc Label: IDwns computer
lﬁl.Ml Y ariable Measurement Level: IDrdinal YI Suggest | Tupe: INumeric LI I j
&l ownpc . )
@ & owntan Urlabeled values: IU wfidth: |4 QEC"TIEI'SZID
@ & ownpda . 0 . . . o
@ ﬁ e Walue Label grid: Enter or edit labels in the grid. “You can enter additional walues at the battom.
@ ﬁ oAty Changed Missing Count Value Label
O & ownver 1 r [ 3588 0|Mo
2 - Il 2511 1|ves
3 [ Il 1 99 Mo ansywer
4 r r
KN 2l
Copy Propertie Unlabeled  alues
Cases scanned: [5400 ’7 From Anather Yariable... To Other Vanables... | ’7 Automatic Labels |

W alue list limit: 200

Paste | Reset | Cancel | Help |

Before we complete the job of modifying the variable properties for ownpc, let's

apply the same measurement level, value labels, and missing values definitions to
the other variablesin the list.

In the Copy Properties group, click To Other Variables.
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Figure 4-26
Apply Labels and Level dialog box

Apply Labels and Level to E

Select the variables that the curmant “
wvariable's value labels,
measurement level, missing valus Cancel |
definition, and format will be copied

to. [Walue label: and mizsing values
are merged. ] Help |

Wariables:

Inthe Apply Labels and Level dialog box, select al of the variablesin the list, and
then click Copy.
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If you select any other variablein the list in the Define Variable Properties main
dialog box now, you'll see that they are all now ordinal variables, with avalue of 99
defined as user missing and a value label of No answer.

Figure 4-27
New variable properties defined for ownfax
Define Yariable Properties [ ]
% canned Vaniable List Cunrent Warnable: Iownfax Label: |Dwns fax machine
lﬁll YWariable Measurement Level: IDrdinaI 'l Suggest | Type: INumeric L” j
&) ownpc - .
0 oy Unlabeled values: ID wiidth: 4 QECImE"SiID
(8] . ownpda Walue Label grid: Enter or edit labelz in the grid. “f'ou can enter additional values at the bottom.
] d
&l ownc
@ oy Changed Mis<sing Count Value Label
O o 1 B N 5198 0[Ma
2 B C 1202 1 |ves
3 rd v 0 33 |Mao answer
4 r r
KN — i
Copy Propertie Unlabeled ¥ alues
Cases scanned: [ga00 ’7 FErom Anather Yariable. . | To Other Varnables... I ’7 Automatic Labels |
Value listimit. [200 0k | Paste | Reset | Cancel | Hep |

» Click OK to save all of the variable properties that you have defined.
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Examining Summary Statistics for
Individual Variables

This chapter discusses simple summary measures and how the level of measurement
of avariable influences the types of statistics that should be used. We will use the
data file demo.sav.

Level of Measurement

Different summary measures are appropriate for different types of data, depending
on the level of measurement:

Categorical. Data with alimited number of distinct values or categories (for example,
gender or marital status). Also referred to as qualitative data. Categorical variables
can be string (alphanumeric) data or numeric variables that use numeric codes to
represent categories (for example, 0 = Unmarried and 1 = Married). There are two
basic types of categorica data:

m Nominal. Categorical data where there is no inherent order to the categories. For
example, ajob category of “sales’ isn't higher or lower than ajob category of
“marketing” or “research.”

m  Ordinal. Categorical data where there is a meaningful order of categories, but
there isn't a measurable distance between categories. For example, thereisan
order to the values high, medium, and low, but the “ distance” between the values
can't be calculated.

79
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Scale. Data measured on an interval or ratio scale, where the data values indicate
both the order of values and the distance between values. For example, a salary of
$72,195 is higher than a salary of $52,398, and the distance between the two valuesis
$19,797. Also referred to as quantitative or continuous data.

Summary Measures for Categorical Data

>

For categorical data, the most typical summary measure is the number or percentage
of casesin each category. The modeisthe category with the greatest number of cases.
For ordinal data, the median (the value above and below which half the cases fal)
may also be a useful summary measure if thereis alarge number of categories.

The Frequencies procedure produces frequency tables that display both the number
and percentage of cases for each observed value of avariable.

From the menus choose:

Analyze
Descriptive Statistics
Frequencies...

Select Owns PDA (ownpda) and Owns TV (owntv) and move them into the Variable(s)
list.

Figure 5-1
Categorical variables selected for analysis
necome category in - :
@1 - _I Y ariable(s]
@ Internet [internet] ® Owns PDA [ownpdal
& Level of education @ Owns TV fonnt] &I
& Warital stabus [marit Fezet |
® Multiple lines [multh c |
@ Mewspaper subscr ﬂl
& Mumber of people i Help |
® Owinz computer [ow
P T S ;I
v Display frequency tables
Statishics... | Chartz... Format... |

Click OK to run the procedure.
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Figure 5-2
Frequency tables

i Viewer !El E

File Edit “iew Inzeit Fomat Analze Graphe  Utlities *indow Help

sE|Sk B = o] D=k @ & ]
@ Crvns T & :I
Log
Frequencies Oowns PDA
Title
Mites Curmulative
@ Statiztics * Freguency FPercent Valid Percent Percent

{E] Frequency T Walid Mo 077 743 783 793
e[ Title Yes 1323 0.7 0.7 100.0 J
~Lg Owns Pl Tatal 5400 100.0 100.0

@ owvrs T

[E] Bar Chart
Title

Owvns
Lo —_—
Log Cumulative
Frequencies | Frequency | Percent | Valid Percent Percent
Title Valid Mo 54 3 ] 3
Notes Yes B346 99.2 99.2 1000
L Stetistics Total 5400 100.0 100.0

Log - -
4 | | | L

The frequency tables are displayed in the Viewer window. The frequency tables
reveal that only about 21% of the people own PDAS, but almost everybody ownsa TV
(99.2%). This might not be an interesting revelation, although it might be interesting
to find out more about the small group of people who do not own televisions.

Charts for Categorical Data

You can graphically display the information in a frequency table with a bar chart
or pie chart.

» Open the Frequencies dialog box again. (The two variables should still be selected.)
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You can use the Dialog Recall button on the toolbar to quickly return to recently
used procedures.

Figure 5-3
Dialog Recall tool

ELE

» Click Charts.

» Select Bar charts and then click Continue.

Figure 5-4
Frequencies Charts dialog box
Frequencies: Charts m
 Chart Typg—————
[l
e Cancel |
(% Bar charts
" Pie charts ﬂl
" Histograms
I~ with nomal curnve

— Chart Values

(¢ Frequencies " Peicentages

» Click oK in the main dialog box to run the procedure.
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Figure 5-5
Bar chart
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In addition to the frequency tables, the same information is now displayed in the form
of bar charts, making it easy to see that most people do not own PDASs but almost
everyone ownsa TV.

Summary Measures for Scale Variables

There are many summary measures available for scale variables, including:

m  Measures of central tendency. The most common measures of central tendency
are the mean (arithmetic average) and median (value above and below which
half the cases fall).

m  Measures of dispersion. Statistics that measure the amount of variation or spread
in the datainclude the standard deviation, minimum, and maximum.

» Open the Frequencies dialog box again.
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» Click Reset to clear any previous settings.

» Select Household income in thousands (income) and move it into the Variable(s) list.

Figure 5-6
Scale variable selected for analysis
- Y ariable(z):
@ fgein years [age] &~ . .
@ Call waling [callwa L Househald income in
& Caller D [calid] &I
@ Gender [gender] Reset |
& Income category in E
® Internet [intermet] ﬂl
® Level of education Help |
@ Marital stabus [marit
T PO [+ P r....m:;l
[ Display frequency tables
Statistics. . Chartz... Farmat... |

» Click Statistics.

» Select Mean, Median, Std. deviation, Minimum, and Maximum.

Figure 5-7
Frequencies Statistics dialog box

Frequencies: Statistics m
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[ Range [~ 5.E. mean

» Click Continue.
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» Deselect Display frequency tables in the main dialog box. (Frequency tables are usually
not useful for scale variables since there may be amost as many distinct values as
there are cases in the data file.)

» Click OK to run the procedure.

The Frequencies Statistics table is displayed in the Viewer window.

Figure 5-8
Frequencies Statistics table
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In this example, there is alarge difference between the mean and the median, with the
mean being more than 25,000 greater than the median. Thisindicates that the values
are not normally distributed. We can visually check the distribution with a histogram.
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Histograms for Scale Variables
» Open the Frequencies dialog box again.
» Click Charts.

» Select Histograms and With normal curve.

Figure 5-9
Frequencies Charts dialog box
Frequencies: Charts m
—Chart Typpg——————————
[l
e Cancel |
" Bar charts
" Pie charts ﬂl
& Histograms
i~ With normal curve

= Chart Values

% Frequencies € Percentages

» Click Continue and click OK in the main dialog box to run the procedure.



87

Examining Summary Statistics for Individual Variables

Figure 5-10
Histogram
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The majority of cases are clustered at the lower end of the scale, with most falling
below 100,000. There are, however, afew cases in the 500,000 range and beyond (too
few to even be visible without modifying the histogram). These high valuesfor only a
few cases have a significant effect on the mean but little or no effect on the median,
making the median a better indicator of central tendency in this example.






Working with Output

Chapter

The results from running a statistical procedure are displayed in the Viewer. The
output produced can be statistical tables, charts or graphs, or text, depending on
the choices you make when you run the procedure. This chapter uses the files
viewertut.spo and demo.sav.

Using the Viewer

Figure 6-1
SPSS Viewer
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The Viewer window is divided into two panes. The outline pane contains an outline
of al of theinformation stored in the Viewer. The contents pane contains statistical
tables, charts, and text output.

Use the scrollbars to navigate through the window's contents, both vertically
and horizontally. For easier navigation, click an item in the outline pane to display
it in the contents pane.

If you find that there isn't enough room in the Viewer to see an entire table or that
the outline view is too narrow, you can easily resize the window.

Click and drag the right border of the outline pane to change its width.

An open book icon in the outline pane indicates that it is currently visible in the
Viewer, athough it may not currently be in the visible portion of the contents pane.

» To hide atable or chart, double-click its book icon in the outline pane.

The open book icon changes to a closed book icon, signifying that the information
associated with it is now hidden.

» To redisplay the hidden output, double-click the closed book icon.

You can also hide all of the output from a particular statistical procedure or al of the
output in the Viewer.
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» Click the box with the minus sign (-) to the left of the procedure whose results you

want to hide, or click the box next to the topmost item in the outline pane to hide
all of the output.

Figure 6-2
Hidden output in the Viewer
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The outline collapses, visually indicating that these results are hidden.

You can also change the order in which the output is displayed.

» Inthe outline pane, click on the items you want to move.
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» Drag the selected itemsto anew location in the outline and rel ease the mouse button.
Figure 6-3
Reordered output in the Viewer
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You can also move output items by clicking and dragging them in the contents pane.

Using the Pivot Table Editor
The results from most statistical procedures are displayed in pivot tables.
Accessing Output Definitions

Many statistical terms are displayed in the output. Definitions of these terms can be
accessed directly in the Viewer.

» Double-click the Owns PDA * Gender * Internet Crosstabulation table.
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» Right-click Expected Count and select What's This? from the pop-up context menu.

The definition is displayed in a pop-up window.

Figure 6-4
Pop-up definition
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Pivoting Tables

The default tables produced may not display information as negtly or as clearly asyou
would like. With pivot tables, you can transpose rows and columns (“flip” the table),
adjust the order of data in atable, and modify the table in many other ways. For
example, you can change a short, wide table into along, thin one by transposing rows
and columns. Changing the layout of the table does not affect the results. Instead, it's
away to display your information in a different or more desirable manner.

» Double-click the Owns PDA * Gender * Internet Crosstabulation table.
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» If the Pivoting Trays window is not visible, from the menus choose:

Pivot
Pivoting Trays

Pivoting Trays provide a way to move data between columns, rows, and layers.

Figure 6-5
Pivoting Trays
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» Click one of the pivot icons to see what it represents. The shaded areain the table
indicates what will be moved when you move the pivot icon. A pop-up label aso
indicates what the icon represents in the table.

Figure 6-6
Pivot icon labels

i% Viewer !El m

File Edit “iew |nzett Piwat Format Analyze Graphs  Utiliies  Window Help
&g o EIJS
Owns PDA * Gender * ||
Internet g
Mo Owns Mo =
FDA L)
Yes R
IStatistics|  H4- T
Total 2224 2285
- 72240 | 22850
49.3% a0.7%
Yes Owns Mo 513 912
FDA 512.5 5125
a0.0% a0.0%
Yoo Eh EnT: i
| vl 4

» Drag the Statistics pivot icon from the Row dimension to the bottom of the Column
dimension. The table isimmediately reconfigured to reflect your changes.
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The order of the pivot icons in a dimension reflects the order of the elementsin

the table.
Figure 6-7

Pivoting tray icon associations

iy Pivoting Traps E - 10]x]
File Edit Yiew Inf—  — pz Utlites Window Help
[Gender1r Cayers | & I [ | =]
£ Columns B
5 @ e
G g L]
o Owns F
ng Fo
i Female
Internet™” / Count Expected Count | % within Owinsg PC
] [ Mo Owns Mo 1807 10034 48.2
FDA  veas 227 3206 50.3
Total 2224 22240 483
Yes Dwns Mo a13 125 50.0
FDA  veas 308 3055 404
Total 818 a18.0 50.0
« | i
[¥ [SPSS Processar isready

» Drag the Owns PDA icon to the left of the Internet icon and release the mouse button
to reverse the order of these two rows

Creating and Displaying Layers

Layers can be useful for large tables with nested categories of information. By
creating layers, you simplify the look of the table, making it easier to read. Layers
work best when the table has at least three variables.

» Double-click the Owns PDA * Gender * Internet Crosstabulation table.

» |If the Pivoting Trays window is not visible, from the menus choose:

Pivot
Pivoting Trays
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» Drag the Gender pivot icon to the Layer dimension.

Figure 6-8

Gender pivot icon in the Layer dimension

i viewertut zpo - SPSS Yiewer

Working with Output

HE | Edit ‘iew Inset Pivot Format Analyze Graphs  Utiiies window Help
|Uender [niernet | | | | ;I
:\_\‘ Pivoling Trapsl E
Owns PDA * Gender * Intern "p" Layers g
i Colurmns| = =
Gender | GenderFemale j| - - =
- z -
Internet Count Eg: g £
wns Mo Ma 1847
=3 | FDa ¥ :
Bs 213 nn |—-_rJ.IrI(
Yes Ma 327
Tes 305 305.5 49.¢
Total o 2224 22240 49
Tes 818 818.0 a0.c
al | v

To view the different layers, you can either click the arrows on the layer pivot icon, or
you can select a layer from the drop-down list in the table.
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Figure 6-9
Choosing a layer
% Outputl - SPSS Viewer [_ [O] x|
Fil= Edit “iew Inzert Piwat Format Analyze Graphs  Utilities Window Help
[Gender* nternel | N ] ] =
Owns PDA * Gender * Internet Crosstabulation
Gender Gender Female j
nt | Expected Court | % within Owns P
Crwins Gender Male aa7 1803.4 4497
= |Poa Total 513 5125 50.0
FERT 327 3206 50,
Yes 305 305.5 496
Total Mo 2274 222410 49
Yes 818 818.0 500
4| | v
1 items selected [0 hidden/collapsed) |T|SF'SS Frocessor is ready =
Editing Tables
Unless you've taken the time to create a custom TablelL ook, pivot tables are created
with standard formatting. You can change the formatting of any text within atable.
Formats that you can change include font name, font size, font style (bold or italic),
and color.
» Double-click the Level of education table.
» |f the Formatting toolbar is not visible, from the menus choose:
View
Toolbar
» Click thetitle text, Level of education.
» From the drop-down list of font sizes on the toolbar, select 12.
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» To change the color of thetitle text, click the Text Color tool and select acolor.

Figure 6-10
Reformatted title text in the pivot table
Formatting Toolbar H
LIEAN =] [rarial =l iz =] B|z|u|®| = i
s Viewer !Elm
. File Edit “iew |nsett Piwot Fomat &nalyze Graphs  Utlities indow Help
] [~
Level of education
Cumulative
Frequency Percent FPercent
Yalid Did not camplete high
schoal 1380 .7 217
» High =school degree 1936 303 52.0
Some college 1360 1.3 732
College degree 1355 1.2 94.4
Fost-undergraduate
degres 358 5.6 100.0
Total 5400 100.0
Crosstabs
-
| | LA 9

You can also edit the contents of tables and labels. For example, you can change the
title of this table.

» Double-click thetitle.

» Type Education Level for the new label.

Note that if you change the values in a table, totals and other statistics are not
recal cul ated.
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Hiding Rows and Columns

Some of the data displayed in atable may not be useful or it may unnecessarily
complicate the table. Fortunately, you can hide entire rows or columns without
losing any data.

» Double-click the Education Level table.
» Citrl-Alt-click on the Valid Percent column label to select all of the cellsin that column.

» Right-click the highlighted column and select Hide Category from the pop-up context
menu.

The column is now hidden but not deleted.
To redisplay the column:
» From the menus choose:

View
Show All

Rows can be hidden and displayed in the same way as columns.

Changing Data Display Formats

You can easily change the display format of datain pivot tables.
» Double-click the Education Level table.
» Click on the Percent column label to select it.
» From the menus choose:

Edit

Select
Data Cells
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» From the menus choose:

Format
Cell Properties

» TypeOinthe Decimalsfield to hide all decimal pointsin this column.

Figure 6-11
Cell Properties dialog box
Cell Properties HE
Walue | Alignment I Margins | Shading |
LCategony: Format;
Mumber HH B HEE-H
Diate B HE
Time i Rcdass et
Currency #HHE+H
it 2
dd-rrram-y
e —e S i{alE —=mmmmm e
mmdd
rarndd » .
dd .y . Percent
ml r
Decimals: IE
¥ &djust farmat for cell width

(u] I Cancel | Apply | Help |

You can also change the data type and format in this dialog box.

» Select the type that you want from the Category list, and then select the format
for that type in the Format list.
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» Click OK to apply your changes and return to the Viewer.

Figure 6-12
Decimals hidden in Percent column
i% Viewer !EIE
File Edit “iew Ingert Piwvot Format Analyze Graphs  Ublibes Window Help
=
Education Level
Statistics
Curnulative
Level of education Freguency | Percent Parcent
Walid Cid not complete high 1300 29 a7
- school
High school degree 1936 a0 52.0
Same college 1360 al 732
College degree 1355 al 944
FPost-undergraduate
degree 3484 B 100.0
Total G400 100
< | v

The decimals are now hidden in the Percent column.

TableLooks

The look and feel of your tables are a critical part of providing clear, concise, and
meaningful results. For example, if your tableis difficult to read, the information
contained within that table may not be easily understood.

Using Predefined Formats
» Double-click the Marital status table.

» From the menus choose:

Format
TableLooks...
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The TableL ooks dialog box lists a variety of predefined styles. Select a style from
the list to preview it in the Sample window to the right.

Figure 6-13
TableLooks dialog box

TableLooks E

TableLook:  <Swstem Default>

—Sample 0K

T ableLook Files:

Cancel
<Sypztem Defaults

Academic [narmow)
Academic [VGa narmow] Cusrs B iors
Acadamic [VGEa) e
Academic 2 [namow) EhEby Vs
Academic 2 [VGEA narmow] oass o

Academic 20WGA) | ™
Academic 2 i
Academic T
Lyant-garde [narmow)] ;I Eracr ImCRCHRRC

Browse... |

" Beset all cell formats to the TableLook

Help

i

iR A
i

Save Laak | Sawve Az | Edit Laak... |

You can use astyleasis, or you can edit an existing style to better suit your needs.

» To use an existing style, select one and click OK.

Customizing TableLook Styles

You can customize aformat to fit your specific needs. Almost all aspects of atable
can be customized, from the background color to the border styles.

» Double-click the Marital status table.

» From the menus choose:

Format
TableLooks...
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» Select the stylethat is closest to your desired format and click Edit Look.

» Click the Cell Formats tab to view the formatting options.

Figure 6-14
Table Properties dialog box

Table Properties HE

Generall Footnotes  Cell Fomnats | Bordersl F'lintingl

—Tent

IA[ia[ j Ig ﬂ ﬂﬂﬂ@ Area |Data j

—Sample
—&lignment
= E[=|a| 5o ==
—Shading —
Foreground:  Background: Frrr—
o -] - e
Tt

— Inner Marginz [in paints)

Top: |‘| 3: Left: IB 3:
Battom: I'I 3: Right: IB 3:

Ok I Cancel | Spply | Help |

The formatting options include font name, font size, style, and color. Additional
options include alignment, shading, foreground and background colors, and margin
sizes.

The Sample window provides a preview of how the formatting changes affect your
table. Each area of the table can have different formatting styles. For example, you
probably wouldn't want the title to have the same style as the data. To select atable
areato edit, you can either choose the area by name in the Area drop-down list, or
you can click the area that you want to change in the Sample window.

» Select Title from the Area drop-down list.

» Select anew color from the Background drop-down list.

The Sample window shows the new style.
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» Click OK to return to the Tablel ooks dialog box.

You can save your new style, which allows you to apply it to future tables easily.
» Click save As.

» Navigate to the desired target directory and enter a name for your new style in the
File Name text box.

» Click save.

» Click OK to apply your changes and return to the Viewer.
The table now contains the custom formatting that you specified.

Figure 6-15
Custom TableLook
i Viewer Hi=1 E3
Fil= Edit “iew Inzett Pivot Fommat Analize Graphs  Utilities  Window Help
Marital status ;I
M Yalid g400
Missing i]
Marital status
Cumulative
Frequency Percent Valid Percent FPercent
Walid Unmarried 3224 a0.4 a0.4 an.4
Warried 376 495 495 100.0
Total H400 100.0 100.0
=
< I

Changing the Default Table Formats

Although you can change the format of atable after it has been created, it may be
more efficient to change the default Tablel ook so that you do not have to change the
format every time you create a table.
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To change the default Tablel ook style for your pivot tables, from the menus
choose:

Edit
Options...

» Click the Pivot Tables tab in the Options dialog box.

Figure 6-16
Options dialog box

General | Yiewer | Drraft Wiewer I Output Labels | Charts I Interactive I

Pivat Tables | Data I Cunency I Scoripts

— TableLook —Sample

A ALookshAcademic [namow].to

< Suztern Dlefault -
sAcademic: [narrow | to 1
Academic WGA narraw] to
Academic WGEA)HD o
Academic 2 [narrow]. to =
Academic 2 [WGEA narow].ta —
Academic 2 WGA)Ho

Academic 2.to ;I o

Browse... | [ —
3. Fusm 'u copreal

Set T ableLaok Directary |

E
ol o
E
:

—Adjuzt Column ‘idths foar ————— ~ Default Editing Mode
' | abels anly " Labels and data IEdit all tables in Wiewer ;I

0K I Cancel | Apply | Help |

» Select the TablelL ook style that you want to use for all new tables.

Use the Sample window to see a preview of each Tablel ook.

» Click OK to save your settings and close the dialog box.

All tables that you create after changing the default Tablel ook automatically conform
to the new formatting rules.
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Customizing the Initial Display Settings

Theinitial display settings include the alignment of objects in the Viewer, whether
objects are shown or hidden by default, and the width of the Viewer window. To
change these settings:

» From the menus choose:

Edit
Options...

» Click the Viewer tab.

Figure 6-17
Viewer options
Data I Currency I Scripts
General Wiewer | Diraft Yiswer I Output Labels I Charts | Interactive I Pivat Tables
— Initial Output State————— | Title Font hd|
PP PR — |tem:
R ZI[ = e 2| o 0|
Contents are initialy. | — Test Output Page Size
& Shaown width: Length:
|.. = Hidden &' Standard (80 characters]) % Standard (59 lines)
Justification: ¢ \wide 132 characters) € Infinite
& Align left
@— c ™ Custor: IBU " Customn: |59
" Center
€ Align right — T ext Output Font
mj Courier Hew j |1U j Bl fl Hl-l'l
™ Dizplay commands in the log W Monospaced fonts

Ok I Cancel Aoply Help
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The settings are applied on an object-by-object basis. For example, you can
customize the way charts are displayed without making any changes to the way tables
are displayed. Simply select the object that you want to customize, and make the
desired changes.

» Click the Title icon to display its settings.

» Click center to display all titlesin the (horizontal) center of the Viewer.

You can aso hide elements, such as the log and warning messages, that tend to
clutter your output. Double-clicking on an icon automatically changes that object's
display property.

» Double-click the warnings icon to hide warning messages in the output.

» Click OK to save your changes and close the dialog box.

Figure 6-18
Centered title in the Marital status table
i%= Yiewer !EIE
Eile Edit “iew [nsett Pivot Fomat Analyze Graphs  Utiliies  Window Help
Il Frequ
Marital status
Cumulative
- Frequency | Percent [ walid Percent Percent
Yalid  Unmarried 3224 50.4 50.4 50.4
Married HTE 495 495 100.0
Total f400 100.0 100.0
< | 2

Your new settings will be applied the next time you run a statistical procedure. All
items that you have hidden will still be created, but they will not be visible in the
contents pane. Centered items can be identified by the small symbol to the left of
the item.
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Displaying Variable and Value Labels

In most cases, displaying the labels for variables and values is more effective than
displaying the variable name or the actua data value. There may be cases, however,
when you want to display both the names and the labels.

» From the menus choose:

Edit
Options...

» Click the Output Labels tab.

Figure 6-19
Output Labels options
Data I Currency I Scripts

General I Wiewer I Diraft Viewer Output Labels | Charts I Interactive I Pivat T ables

— Outline Labeling
Wariables in item labels shown as:

I Labels j

‘Wariable values in item labelz shown as:

I Labels LI

—Pivot Table Labgling————

‘Yariables in labels shown as:

Wariable values in labels shown as:

Labels j

0k I Cancel | Apply | Help |

You can specify different settings for the outline and contents panes. For example, to
show labelsin the outline and variable names and data values in the contents:
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» Inthe Pivot Table Labeling group, select Names from the Variables in Labels
drop-down list to show variable names instead of labels.

» Then, select Values from the Variable Values in Labels drop-down list to show data
values instead of |abels.

Figure 6-20
Pivot Table Labeling settings
Data I Currency I Scripts

General I Wiewer I Diraft Viewer Output Labels | Charts I Interactive I Pivat T ables

— Outline Labeling
Wariables in item labels shown as:

ILabeIs j
‘Wariable values in item labelz shown as:
ILabeIs LI

— Pivot T able Labeling
‘Yariables in labels shown as:

Mames LI

Wariable values in labels shown as:

0k I Cancel Apply Help
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The new settings are applied the next time you run a statistical procedure.

Figure 6-21
Variable names and values displayed
i Yiewer !Elm
Fil= Edit “iew Inzett Fommat Analyze Graphs  Utilities  ‘Window  Help
2RISR b = o Ok @] & ]
€|2] +| -] @o] ==18]
Statistics s
MARITAL
I Valid 6400
Mizsing 0
MARITAL
Curmulative
Frequency Percent Yalid Percent Percent
Walid i} 3224 504 a0.4 a0.4
1 MTE 49.6 49.6 100.0
Total 6400 100.0 100.0
4| | il

Using Results in Other Applications

Your results can be used in many applications. For example, you may want to
include a chart or graph in a presentation or report. Applications such as Microsoft's
PowerPoint or Word can display your results as plain text, rich text, or as a metéfile,
which isagraphical representation of the output.
The following examples are specific to Microsoft Word, but they may work
similarly in other word processing applications.
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Pasting Results as Rich Text

You can paste pivot tables into Word as native Word tables. Text formatting, such
as font size and color, is not retained, but columns and rows are properly aligned.
Because the table is in a text format, the data can be edited after you paste it into
your document.

» Click the Marital status tablein the Viewer.
» From the menus choose:

Edit
Copy

» Open your word processing application.
» From the word processor's menus choose:

Edit
Paste Special

» Select Formatted Text (RTF) in the Paste Special dialog box.

Figure 6-22
Paste Special dialog box
Paste Special nm
Source!  Unknown
Cancel |
* paste:

" Paste lirk:

d I Display as icon

esulk

Inserts the contents of the Clipboard as text with

fFont and kable Farmatting.
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» Click OK to paste your results into the current document.

Figure 6-23
Pivot table displayed in Word

L_Ei Document] - Microsoft Word Hi=E
JEiIe Edit Wiew Insert Format Tools Table Window Help LI|
DeEalalky | s2ed v e@O v -3 2
EI%- L I T TS B SR S S N -S-EE
Marital status
Cumulative
Freguency | Percent | “alid Percent Percent
Valid Unmarried 3224 50.4 50.4 50.4
Married 3176 49.6 49.6 100.0
Total G400 100.0 1000

|«|0|»|<

The table is now displayed in your document. You can apply custom formatting, edit
the data, and resize the table to fit your needs.

Pasting Results as Metafiles

Pasting your results as metafiles maintains the formatting of your output. Your pasted
output becomes an image in the target document.

» Click the Marital status tablein the Viewer.
» From the menus choose:

Edit
Copy
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» Open your word processing application.

» From the word processor's menus choose:
Edit
Paste Special

» Select Picture in the Paste Special dialog box. (In some applications, the choice
may be “metafile” instead of “Picture)

Figure 6-24
Paste Special dialog box

Paste Special HE

Source!  Unknown

As:

: Cancel |
& Paste: Formatted Text (RTF) ;I

¢ Paste link: Unformatted Text

LI ™ Display as icon

esult

— Insetts the contents of the Clipboard as a picture.
r. This farmat is better than Bitmap For printing to high
E quality printers, OF the Format options available,
Picture occupies the least space on disk and displays
the quickest in Word,

» Click OK to paste your results into the current document.
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Figure 6-25

Metafile displayed in Word

L'._Ei Documentt - Microzoft Word [_ [O] x|
J Elle Edit %iew Insert Format Tools Table Window Help ﬂ
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Marital status

- CL
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Total £400 100.0 100.0
- h-[ =
R o]
i ¥

The metafile is now embedded in your document. Thisimage is a snapshot of the
Marital statustable. Only the visible portions of the table are copied. Information in
hidden categories or layersis not included in the metafile.

Pasting Results as Text

Pivot tables can be copied to other applications as plain text. Formatting styles are not
retained in this method, but you gain the ability to edit the table data after you paste
it into the target application.

» Click the Marital status tablein the Viewer.
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>

>

>

>

From the menus choose:
Edit
Copy

Open your word processing application.

From the word processor's menus choose:
Edit
Paste Special

Select Unformatted Text in the Paste Special dialog box.

Figure 6-26
Paste Special dialog box

Paste Special HEBE

Source:  Unknown

() Paste:
 Paste link:

‘Linformatted Tesxt
Picture

LI ™ Display as icon

esulk
Insetks the conkents of the Clipboard as text without

.ﬂ" any Formatting
% 0

» Click OK to paste your results into the current document.
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Figure 6-27
Pivot table displayed in Word

Do entb 050 ord - 1O
JFiIe Edit Wiew Insert Format Tools Table Window Help
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Each column of the table is separated by tabs. You can change the column widths by
adjusting the tab stops in your word processing application.

Exporting Results to Microsoft Word and Excel Files

SPSS alows you to export results to a single Microsoft Word or Excel file. You can
export selected items or al itemsin the Viewer, and, if exporting to Word, you can
export charts as embedded Windows metafiles. This topic uses the files msouttut.spo
and demo.sav.

In the Viewer's outline pane, you can select specific items that you want to export.
You do not have to select specific items.
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» From the Viewer menus choose:
File
Export...

There are several options for exporting the results.

Figure 6-28
Export Output dialog box
Expoit Dutput | x|
Export: Dutput Document Options...
Ehiart Siez...
i~ Export File
File Name: | *Program Files\SPSSLW0UTPUT M
—E=part What———————— Expart Farmat
= All Objects File: Tupe:
 AllVizihble Dbjects -
IW’ordz’FlTF file [*.dac) -
€ Selected @hjects

ok I Cancel | Help |

First, you can select which type of output file you want to create. For Word, you can
create afile that contains charts (Output Document) or one that does not contain
charts (Output Document (No Charts)). Charts are embedded in the Word document
as Windows metafiles. For Excel, you can create only documents that do not contain
charts (Output Document (No Charts)).

» Select Output Document from the Export drop-down list.

You can save the exported Word or Excel file to any location and assign it any name
that Windows allows. The default file nameis OUTPUT, and the default path is the
installation location or, if you opened or saved an output file, the location of that
file. You can change the default by typing a new path or clicking Browse to locate
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adestination. You do not have to specify afile extension. The export functionality
adds the appropriate extension.

Note the default file path in the File Name text box. You will need to know where
the fileis to open it in Word.

Instead of exporting all objects in the Viewer, you can choose to export only
visible objects (open books in the outline pane) or those that you selected in the
outline pane. If you did not select any items in the outline pane, you do not have
the option to export selected objects.

Select All Objects in the Export What group.

Finally, you select the file format.
Select Word/RTF file (*.doc) from the File Type drop-down list.

Click OK to generate the Word file.

When you open the resulting file in Word, you can see how the results are exported.
Notes, which are not visible objects, appear in Word because you chose to export all
objects.

Figure 6-29
Output.doc in Word
2l OUTPUT.DOC - Microsoft Word [_[o]x]
| Bl Edt View Insert Fomet ook Table Window Help Acrobat 5||
Frequencies ﬂ
Notes
Outaut Created | 23-JAN-2003
Comments |
Input Data cF
Files\SPSStutorialeample_fil
Filter | .
Weight | =
SplitFile
: EElRE K L4
[Page 1 Sec 1 1z [a 1 In1  Coll |[ReC [TRK | 4




120

Chapter 6

Pivot tables become Word tables, with al of the formatting of the original pivot table,
including fonts, colors, borders, and so on.

Figure 6-30
Pivot tables in Word
&l OUTPUT.DOC - Microsoft Word [_ o] x]
| Ble Edit wew Insert Format Tooks Table window Help Acrobat 5[‘
Frequency Table ZI
Gender [
Cumul:
Freguency Fercent Valid Percent Ferce
Valid Female 3179 497 497
Male 3221 50.3 50.3
Total 8400 100.0 100.0 =
=
o
Income category in thousands 5
: B E=(4 »
[Page 1 Sec 1 ERCES Inl coll REC [TRE [ A

Charts become embedded Windows metafiles.

Figure 6-31
Charts in Word

&8 DUTPUT.DOC - Microsoft Word [_ O] %]
JEi\e Edit Wew Insert Format Tools Table Window Help Acrobat ﬁl|
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Text output is displayed in afixed-pitch font.

Figure 6-32
Text output in Word

i} DUTPUT.DOC - Microsaft Word M= &3
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If you export to an Excel file, results are exported differently.

Figure 6-33
Output.xls in Excel

EJ Microsoft Excel - OUTPUT .xls [_ =] x]
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Pivot table rows, columns, and cells become Excel rows, columns, and cells.

Figure 6-34
Pivot tables in Excel
B2 Microsoft Excel - DUTPUT .xis [_ o] x]
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14 A ¥} Sheet / 14 _>|JJ
Ready | [ WM[ [T 4

Each line in the text output isarow in the Excel file, with the entire contents of the
line contained in asingle cell. Charts are not exported at all.

Figure 6-35
Text output in Excel
B2 Microsoft Excel - DUTPUT .xis [_ o] x]
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7
|72
|73 under ses 38 B
|74
|75 s25 - 34 ag 3 [
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77 350 - 574 a3 3 -
[ [ al¥ [vil sSheet / /N — |
Ready | [ WM[ [T 4
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Exporting Results to HTML and Text Formats

You can also export results to HTML (hypertext markup language) and text formats
and a number of graphic formats. When saving as HTML and text, all non-graphic
output from SPSS can be exported into a single file and read by other programs.
HTML format is commonly used for intranet and Internet Web pages, while text can
be read by all word processors. In thisway, SPSS output can be easily incorporated
into documents on computers that do not run SPSS or onto Web pages.

When you export HTML and text output, charts can be exported as well, but
not to a singlefile.

Figure 6-36
Chart in HTML

; <1--Text used as the document title [dizplayed in the title bar].... !EIB

File Edit “iew Favoites Tool: Help ﬁ
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Each chart will be saved as afilein aformat that you specify, and references to these
graphics fileswill be placed in the HTML or text document created by SPSS. Thereis
also an option to export all charts, or selected charts, in separate graphics files.

Figure 6-37
References to graphics in HTML output
4 OUTPUT.HTHM - Notepad [_ O] x|
File Edit Format Help
< /CEMTER>
3 <I--Text used || Fiz]-5N LI
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<Hl>Report
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7

Creating and Editing Charts

A wide variety of chart types are available, and many of those charts are available in
two different formats:

m  Standard charts. Charts created from the main Graphs menu and charts created by
statistical procedures.

m Interactive charts. Charts created from the Interactive submenu of the Graphs
menu and charts created from pivot tables.

The examplesin this chapter use the data file demo.sav.

Creating Standard Charts

In this example, welll create a simple pie chart that shows how many respondents
have Internet service at home.

» From the menus choose:

Graphs
Pie...

125



126

Chapter 7

» Click Summaries for groups of cases and then click Define.

Figure 7-1
Pie Charts dialog box

Pie Charts m

Data in Chart Are
& Summaries for groups of cases
" Summaries of separate varables

 Walues of individual cazes

dil

Cancel

Help

Since we want to base the chart on a single variable, we selected Summaries for groups
of cases. Chart elements (bars, pie sices) can also be based on summaries of separate

variables or values from individual cases in the datafile.

Figure 7-2
Define Pie dialog box

Select Internet as the variable that defines dlices (Define Slices by).

: Define Pie: Summanes for Groups of Cazes
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@ Call weaiting [calbvail
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Charge Surmmar... |
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@ Mewezpaper subscri
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K
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Cancel

Help

HHHE

Titles...

il

Optiors

When charts are created, they do not show the missing category by default. You want
to display this category to make sure that the number of cases with missing values

iS not excessive.
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» Click Options.

» Select Display groups defined by missing values, and then click Continue.

Figure 7-3
Options dialog box
i~ Mizzing Y alue: -Eontlnue
% Exclude cases listwise -
Cancel
 Exclude cases variable by variable ﬂl
Help
V¥ Display groups defined by missing values _I
™| Display chart with case labels

» Click ok in the Define Pie dialog box to create the pie chart.

Figure 7-4

Pie chart

7% Outputd - SPSS Viewer [_ o] x]

File Edit ‘“iew Data Transform Insett Format Analyze Graphs  Utlities ‘Window Help

Z|=| S| w2 o Bl=|] 9] & ¢

B8 output B

=--{E Graph Internet

Title B Missing
Mates Mo
“-a[j) Pie of caunt b O ves

The pie chart reveal sthat most respondents do not have I nternet service at home. From
the chart, it appears that only about a quarter of the respondents have Internet service.
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Editing Standard Charts

You can edit charts in avariety of ways. For the sample pie chart we created, we will:
m  Add atitle.

m  Remove the small category of missing data.

m  Display percentages for the two remaining categoriesin the chart.

The first thing we'll do is add atitle.

» Double-click the pie chart to open it in the Chart Editor.

Figure 7-5
Pie chart in the Chart Editor

File Edt Wiew Chartt Help
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[
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The pie chart fills up al of the available space, leaving no room for the title.
Therefore, before adding the title, we need to resize the data frame. The dataframeis
the frame around the pie chart.
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Select the dataframe. When it is selected, you will see selection handles for the frame.

Position the mouse cursor over the bottom right resizing handle so that a two-headed
arrow appears.

Click while pressing Shift, and drag the frame to resize it. Pressing and holding Shift
maintains the frame's aspect ratio, which is the ratio of width to height.

After resizing the frame, you need to move it to make room for the title text box.

Position the mouse cursor over the frame's border. When afour-headed arrow appears,
click and drag the frame to a new location that provides space for the title text box.

Now you can add the title.

From the Chart Editor menus choose:

Chart
Add Chart Element
Text Box

Type Home Internet Service into the text box, and then press Enter.
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A descriptive title is now displayed above the pie chart. You can move the text box if
desired.

Figure 7-6
Pie chart with title

File Edt Wiew Chatt Help

|| ariai 1 EH| B I
M Missing

E Mo
O ves

Now we'll remove the small category of missing data.
» Select the pie chart.
» From the Chart Editor menus choose:

Edit
Properties

» In the Properties window, click the Categories tab.
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» Move Missing from the Order list to the Excluded list.

Figure 7-7
Categories tab

Properties n

Chart Size | Fil & Border  Categories | Depth & sngle |
Watiahle: Ilr'rternet vl
r Collapze (sum) categories lessthan: |5 %
—iCategories
Crrcler:
Mo i |
Yes |
-
X
Excluded:
Losver mardin (32 I Upper margin () I
Apply Cancel | Help |

» Click Apply.
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The category of missing data has been removed from the pie chart, leaving only
two categories.

Figure 7-8
Pie chart without missing category

File Edt Wiew Chart Help
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The pie chart clearly shows that most respondents do not have Internet service
at home, and it looks like amost three-quarters of the respondents are in the No
category. However, it might be useful to see the exact percentages.

» Select the pie chart.

» From the menus choose:

Chart
Show Data Labels
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Now the pie chart displays labels of counts. We need to change the labels to
percentages.

Figure 7-9
Pie chart with counts

File Edt Wiew Chatt Help

| arial 7 A B oI

Internet
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Home Internet Service

» Onthe Data Value Labels tab, move Count from the Contents list to the Available list.
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» Move Percent from the Available list to the Contents list.

Figure 7-10
Data Value Labels tab

FProperties m

Chart Size | Text | Fil & Border | Categories Data Yalue Labels |
~Lahel
Cortents:

[x ||

Available:
internet
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[

~Lakel Position
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» Click Apply.
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Now percentages are displayed in the pie slices.

Figure 7-11
Pie chart with percentages

File Edt Wiew Chatt Help

| arial sy =B or|

Internet

B Mo
O Yes

Home Internet Service

The percentages are based on the two categories displayed (73.4 + 26.6 = 100). If
you put the category containing missing values back into the pie, the percentages

will change.

Creating Interactive Charts

Interactive charts are created by selecting a chart type from the Interactive submenu
of the Graphs menu.
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» From the menus choose:

Graphs
Interactive
Bar...

» Drag and drop Owns PDA (ownpda) into the x (horizontal) axis list.

» Drag and drop Income category in thousands (inccat) into the Color list.

Figure 7-12
Create Bar Chart dialog box
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» Click OK to create the chart.
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Figure 7-13
Interactive bar chart
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Bars show courts
-
5
5 1000
Q
500

0.00 0.25 .50 075 1.00
Owns PDA

You might notice that this is not a particularly attractive chart. That's because
interactive graphs treat scale and categorical variables differently, and Owns PDA
(ownpda) is defined as a scale variable. Sincethisisrealy acategorical variable, we
could change the variable definition in the Data Editor. Or we could simply tell the
interactive graphics procedure to treat it as a categorical variable.

» Open the interactive bar chart dialog box again.

» Right-click on Owns PDA (ownpda) on the x (horizontal) axis list.
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» Select Categorical from the pop-up context menu, and then click OK to create the chart.

Figure 7-14
Variable type context menu
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Now the clustered bar chart looks much better.
Figure 7-15
Interactive bar chart
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Editing Interactive Charts

You can modify both interactive and standard charts; however, interactive charts can
be edited directly in the Viewer.

» Double-click the chart to activate it.
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Interactive charts are activated and edited in place in the Viewer window, while
standard charts open in a separate window for editing.

Figure 7-16
Activated interactive chart
BHMETY o b m | | = =B
21|E
Ja
2000
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i

To change the color of abar, you simply click abar to select it, and then select another
color from the Fill Color palette on the vertical toolbar. However, in this clustered bar
chart example, colors are associated with pairs of bars, so you change the color by
selecting the bar category in the legend.

» Click the color square next to the $25-$49 category in the legend.
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» Click the down arrow next to the Fill Color icon on the vertical toolbar, and select

anew color.

Figure 7-17
Fill Color palette
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The color is applied to the two bars that represent the $25-$49 category.
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In this example, the key text below the legend is unnecessary since the scale axisis
already labeled Counts. To delete the key text:

Right-click on the text and select Hide key from the pop-up context menu.

Figure 7-18
Right-mouse context menu
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Figure 7-19
Key text hidden below legend

Creating and Editing Charts
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The key text is now hidden.

Creating an Interactive Chart from a Pivot Table

You can create interactive charts from data contained in a pivot table but first you
need a pivot table.

» From the menus choose:

Analyze

Descriptive Statistics
Crosstabs...
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» Select Income category in thousands (inccat) as the row variable.

» Select Owns PDA (ownpda) as the column variable.

Figure 7-20
Crosstabs dialog box
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» Click OK to run the procedure.

» Double-click the pivot table to activate it.
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» Click and drag to select the data cells you want to use in the chart.

Figure 7-21
Data selected in pivot table
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» Right-click anywhere in the selected area.

» From the pop-up context menu choose:

Create Graph
Bar
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An interactive chart of the selected data is created.

Figure 7-22
Clustered bar chart created from pivot table
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Working with Syntax

SPSS syntax provides a method for you to control the product without navigating
through dialog boxes, viewers, or data editors. Instead, you control the application
through syntax-based commands. Nearly every action you can achieve through the
user interface can be achieved through syntax. Using syntax also allows you to
save the exact specifications used during a session. Syntax is not available with the
Student Version.

The examples in this chapter use the data file demo.sav.

Pasting Syntax

The easiest way to create syntax is to use the Paste button located on most dialog
boxes.

» Open demo.sav for use in this example.

» From the menus choose:

Analyze
Descriptive Statistics
Frequencies...

147
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vV v v v v v Vv

This opens the Frequencies dialog box.

Figure 8-1
Frequencies dialog box

® Age in years [age] j Yariable[s] k.

@ Years ot current ad iMartal status [marital]
4 Household income

Baste

iz

& Income category in Beset
® Price of primary wet E

. . . Cancel
@ Primary vehicle pric
& Level of education Help
G Years with curent
R Vb T ;I

¥ Display frequency tables

§tatistics...| Qhalts...l Eormat...l

Select Marital status (marital) in the source list.

Click the arrow button to move the variable to the Variables list.
Click Charts.

In the Charts dialog box, select Bar charts.

In the Chart Values group, select Percentages.

Click Continue.

Click Paste to copy the syntax created as a result of the dialog box selections to
the Syntax Editor.
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Figure 8-2
Frequencies syntax

BEi Syntax2 - SPSS Syntax Editor [_ [O] x|
File Edit “iew Analyze Graphs Utlities Bun ‘window Help

S EREERTNE R
FREQUEMCIES

WARIABLES=marital

/BARCHART PERCEMT

JORDER= AMNALYSIS

[% [SPSS Processar is e

You can use this syntax alone, add it to a larger syntax file, or refer toitina
Production Facility job.

» To run the syntax currently displayed, from the menus choose:

Run
Current
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Editing Syntax

In the syntax window, you can edit the syntax. For example, you could change
the subcommand /BARCHART to display frequencies instead of percentages. (A
subcommand is indicated by a dlash.)

Figure 8-3
Modified syntax

B Syntax2 - S5P5S5 Syntax Editor [_ [O] x|
File Edit “iew Analyze Graphs Utilities Bun ‘Window Help

S EREERTNE R
FREQUEMCIES
WARIABLES=marital

/BARCHART FREQ
JORDER= ANALYSIS |

[% [SPS% Processor is e 7

To find out what subcommands and keywords are available for the current command,
click the Syntax Help button. The example shows the complete syntax for the
FREQUENCIES command.
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Figure 8-4
FREQUENCIES syntax help
g2 Base System [_ [O] x|

G = =2 8 [

Shaw Back  Forward  Stop Refresh Options

|

Frequencies Command Syntax

FREQUENCIES [VARIAELES=]varlist
[/FORMAT=[{DVALUE}] [{MOTALELE 1]
{AFREQ }  {LINIT(n)}
{DFREQ }
[/MISSING=INCLUDE]
[/BEARCHART=[MIN(n)] [MAX(n)] [{FREQ(n) 111
{PERCENT (n) }
[/PIECHART=[MIN(n)] [MiX(n)] [{FREQ }]

{ PERCENT}
[{MISSING  }]]
{HONNISS ING}
[/HISTOGRAM=[MIN (n)] [MAX(n)] [{FREQ(n) 1]
{PERCENT (n) }
| [ {NOMORMALY] [ INCREMENT (n) 1] -
4 3

If the cursor is not in a command, clicking the Syntax Help button displays an
alphabetical list of commands. You can select the one you want.

Typing Syntax

You can type syntax into a syntax window that is already open, or you can open anew
syntax window by choosing:

File
New
Syntax...
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Saving Syntax

To save a syntax file, from the menus choose:
File

Save
or

File
Save As...

Either action opens the standard dialog box for saving files.

Opening and Running a Syntax File

>

>

To open a saved syntax file, from the menus choose:
File
Open
Syntax...

Select a syntax file. If no syntax files are displayed, make sure Syntax (*.sps) iS
selected in the Files of type drop-down list.

Click open.

» To run the syntax currently displayed, from the menus choose:

Run
Current

If the commands apply to a specific datafile, the data file must be opened before
running the commands, or you must include a command that opens the datafile. You
can paste this type of command from the dialog boxes that open datafiles.
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Modifying Data Values

The data you start with may not always be organized in the most useful manner for
your analysis or reporting needs. You may, for example, want to:

m Create a categorical variable from a scale variable.
m  Combine several response categories into a single category.

m Create a new variable that is the computed difference between two existing
variables.

This chapter uses the data file demo.sav.

Creating a Categorical Variable from a Scale Variable

Several categorica variables in the data file demo.sav are, in fact, derived from scale
variablesin that datafile. For example, the variable inccat is simply income grouped
into four categories. This categorical variable uses the integer values 14 to represent
the following income categories: less than 25, 25-49, 50-74, and 75 or higher.

To create the categorical variable inccat:
» From the menus in the Data Editor window choose:

Transform
Visual Bander...
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Figure 9-1
Initial Visual Bander dialog box
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Intheinitial Visual Bander dialog box, you select the scale and/or ordinal variables
for which you want to create new, banded variables. Banding means taking two or
more contiguous values and grouping them into the same category.

Since the Visual Bander relies on actual values in the datafile to help you make
good banding choices, it needs to read the datafile first. Since this can take some
time if your data file contains alarge number of cases, thisinitial dialog box also
allows you to limit the number of casesto read (“scan”). Thisis not necessary for
our sample datafile. Even though it contains more than 6,000 cases, it does not
take long to scan that number of cases.

» Drag and drop Household income in thousands [income] from the Variableslist to the
Variables to Band list, and then click Continue.
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Figure 9-2
Main Visual Bander dialog box
Yisual Bander
Scanned Variable List: Hame: Label:
L...| variable Current Variable: Iincome IHousehoId income in thousands
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» Inthe main Visual Bander dialog box, select Household income in thousands
[income] in the Scanned Variable List.

A histogram displays the distribution of the selected variable (which in this case is
highly skewed).

» Enter inccat2 for the new banded variable name and Income category (in thousands)
for the variable label.

» Click Make Cutpoints.
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Figure 9-3
Visual Bander Cutpoints dialog box

% Equal width Intervals R

r Interals - fill in at least two fields

Firgt Cutpoint Location: 25.00 Catcel |
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o Apply will replace the current cutpaint definitions with thiz specification.

A final interval will include all remaining values.

» Click Equal Width Intervals.

» Enter 25 for the first cutpoint location, 3 for the number of cutpoints, and 25 for

the width.

The number of banded categories is the number of cutpoints plus one. So, in this
example, the new banded variable will have four categories, with the first three
categories each containing ranges of 25 (thousand) and the last one containing all

values above the highest cutpoint value (75).

» Click Apply.
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Figure 9-4
Main Visual Bander dialog box with defined cutpoints
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L[ Vaiable Current Variable: Iincome IHousehoId income in thousands
f Household income in thou:  Banded Variable: |inccat2 |Income categary [in thousands)

Minimum: IS-UU Monmizsing Y alues E I'I 11E.00
‘ T T T T
9.00 14738 Pt 43413 S62.50 TO0.8% 839.25 arv.a3 1116.00
T8.19 216,56 254.04 40221 621,60 TP0.06 ap2.44 104681 118519

Enter interval cutpoints ar click Make Cutpoints for automatic intervals. A cutpaint value
o of 10, for example, defines an interval starting above the previous interval and ending at
Grid:

K — 0|

10.
Cazes Scanned: IW Value Label Ut et
1 2500 " Included [<=)
Mizsing Yalues: ID 2 50.00 & Excluded [<)
3 F5.00
CopyBands ——————— 4 HIGH Make Cutpaoints... |
Eram Snether i anable.. | = fiske T abei

To Other Wariables.... | [" Reverse zcale

kK | Paste | Reset | Cancell Help |

The values now displayed in the grid represent the defined cutpoints, which are
the upper endpoints of each category. Vertical lines in the histogram also indicate
the locations of the cutpoints.

By default, these cutpoint values are included in the corresponding categories. For
example, the first value of 25 would include al values less than or equal to 25. But

in this example, we want categories that correspond to less than 25, 25-49, 50-74,
and 75 or higher.

» Inthe Upper Endpoints group, select Excluded (<).

» Then click Make Labels.
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Figure 9-5

Automatically generated value labels

Visual Bander

Scanned Variable List:

L...| varable

Mame:

Label:

Current ¥ ariable: |income

IHousehoId income in thousands

f Houzehold income in thous Banded W ariable: |inccat2

Minirumn: IS.DD

|Income categony (in thousands)

Monmizsing Y alues

b axeirnam: I'I 116.00

T T T T T T T T
9.00 14738 8475 41413

T T T T T
52,50 0085 839

T T T T 1
Bl 1116.00

25
T8.19 216,56 254.04 40221 621,60 TP0.06 ap2.44 104681 118519
Enter interval cutpoints ar click Make Cutpoints for automatic intervals. A cutpaint value
A _’I o of 10, for example, defines an interval starting above the previous interval and ending at
_I_I Grid: 10
Cazez Scanned: 5400 Value Label Upper Endpaints
1 25.00 |<25.00 " Included [<=]
Mizsing Yalues: ID 2 50.00 |25.00 - 43.00 & Excluded [<)
3 75.00 (50.00 - 74.00
CopyBands ——————— |4 HIGH |75.00+ Make Cutpaints... |
E
Eram fnothen Y ariable... | TR i
To Other Wariables.... | [" Reverse zcale
kK | Paste | Reset | Cancel | Help |

This automatically generates descriptive value labels for each category. Since the
actual values assigned to the new banded variable are ssimply sequential integers

starting with 1, the value labels can be very useful.

You can aso manually enter or change cutpoints and labels in the grid, change
cutpoint locations by dragging and dropping the cutpoint lines in the histogram, and
delete cutpoints by dragging cutpoint lines off the histogram.

» Click OK to create the new, banded variable.
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The new variable is displayed in the Data Editor. Since the variable is added to the
end of thefile, it is displayed in the far right column in Data View and in the last
row in Variable View.

Figure 9-6

New variable displayed in Data Editor

demo.say - P95 Data Editor
File Edit “ew Data Transform Analyze Graphs Utilities Window Help

= B

S|=|S| =] o] D =]k sl F| BlEE [ 2
|1 ; income |?2
owhpc owhfax FEws response inccat2 ;I
1 Mo Mo Yes Mo| 5&0.00-74.00
2 Mo Mo Yes Yes 75.00+
3 Yes Mo Mo Mo| 2500 -49.00
4 Yes Yes Mo Mo| 2500 -43.00
4 Mo Mo Mo Mo <25.00
53 Yes Mo Yes Mo 78 00+
7 Mo Mo Yes Mo| 25,00 -459.00
8 Yes Mo Yes Mo| 50.00-74.00
9 Mo Mo Mo Mo <2500
10 Mo Yes Mo Yes 75.00+
TlTI‘:E)ata \ﬁew\;(p\fariahle Vier\\njvnf Hﬂn i J’:ﬂ -4 m_bl_/,I_

Computing New Variables

You can compute new variables based on highly complex equations, using a wide
variety of mathematical functions. In this example, however, we will smply compute
anew variable that is the difference between the values of two existing variables.

The data file demo.sav contains a variable for the respondent's current age and
avariable for the number of years at current job. It does not, however, contain a
variable for the respondent's age at the time he or she started that job. We can create
anew variable that is the computed difference between current age and number of
years at current job, which should be the approximate age at which the respondent

started that job.
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» From the menus in the Data Editor window choose;

Transform
Compute...

» For Target Variable, enter jobstart.

» Select Agein years (age) in the source variable list and click the arrow button to copy
it to the Numeric Expression text box.

» Click the minus (=) button on the calculator pad in the dialog box (or the minus
key on the keyboard).

» Select Years with current employer (employ) and click the arrow button to copy it
to the expression.

Figure 9-7
Compute Variable dialog box
i Compute Yariable m
T arget ¥ ariable: umeric E sprezsion;
Iiobstalt = age-employ J
TypetLabel.. | _I
L= e in vears [age] !
@Eall waiting [callvia LI LI_I _I_I_I Functions: E
gEaIIBCrIID[[caIEd]] j ilzll :II:II_I iﬁ?}[ﬂum”?” o) ﬂ
¢ Gender [gender - 1] 2] 3] test value, value....
@ Household income ARSINInumexpr)
; il il_l LI_I ARTAMN[numespr]
@ Income category (i ~ COFNORMzvalie)
%Income cateqory in _I I []I Delete COF.BERMOULLI[gG.p) _I
Internet [internet]
®Job zatisfaction [job If.. |
> Age started current
i Level of educatmn_l QK I Paste | Feset | Catcel | Help |

Note: Be careful to select the correct employment variable. There is aso arecoded
categorical version of the variable, which is not what you want. The numeric
expression should be age-employ, not age-empcat.

» Click OK to compute the new variable.
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The new variable is displayed in the Data Editor. Since the variable is added to the
end of thefile, it is displayed in the far right column in Data View and in the last
row in Variable View.

Figure 9-8

New variable displayed in the Data Editor

Data Editor

File Edit “iew Data Transform  Analyze Graphs  Utilities  ‘Window  Help

= E

SR|S| B o] 1) =|k] @ Fliz BR[S9
|1 ; age |55

nEws response | inccat2 jobstart war V;I

1 Yes Mo 3.00 3200

2 Yfes fes 4.00 21.00

3 Mo Mo 2.00 24.00

4 Mo Mo 2.00 24.00

5 Mo Mo 1.00 20,00

] Yeg Mo 4.00 32.00

7 Yes Mo 2.00 32.00

g Yes Mo 3.00 34.00

g Mo Mo 1.00 35.00

10 Mo Yes 4.00 2200
d_lTl":E)ata \ﬁe:\-h;( Vel o 7 |mﬂ Fr o v[

Using Functions in Expressions

You can also use predefined functions in expressions. The function list contains more

than 70 built-in functions, including:

m  Arithmetic functions

Statistical functions
Distribution functions
Logica functions

Missing-value functions
Cross-case functions
String functions

Date and time aggregation and extraction functions
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For information on specific functions, right-click the function you want to know
about or click Help in the Compute Variable dialog box.

Pasting a function into an expression. To paste a function into an expression:

Position the cursor in the expression at the point where you want the function to
appear.

Double-click the function in the Functions list (or select the function and click the
arrow above the Functions list).

The function is inserted into the expression. If you highlight part of the expression
and then insert the function, the highlighted portion of the expression is used as the
first argument in the function.

Editing a function in an expression. The function is not complete until you enter the
arguments, represented by question marks in the pasted function. The number of
question marks indicates the minimum number of arguments required to complete
the function.

Highlight the question mark(s) in the pasted function.

Enter the arguments. If the arguments are variable names, you can paste them from
the variable list.

Using Conditional Expressions

>

You can use conditional expressions (also called logical expressions) to apply
transformations to selected subsets of cases. A conditional expression returns avalue
of true, false, or missing for each case. If the result of a conditiona expression is
true, the transformation is applied to that case. If the result is false or missing, the
transformation is not applied to the case.

To specify a conditional expression:

Click If in the Compute Variable dialog box.



163

Modifying Data Values

This opens the If Cases dialog box.

Figure 9-9
If Cases dialog box

Compute Yariable: If Cazes [ x|

Age in years [age] u ' Include all cases

Ty _— nclude if case satisfies condition:
> Warital status [marit O Include i f d _I
3> Years at current ad =
# Household income
@ Income categom in ;I
> Price of primany vek _
> Primany vehicle pric LI LILI ililil Functions; E
® Level of education _I ilﬁl ﬂilil &BS[numespr] -
® Years with cument | =2 =2 L ] A st value. value,.. :I
> Rietired [retire] _I _I_I _I_I_I ARSIN[numexpr)
> Years with current | Al o] éggﬁggﬁ?wﬁr] I

— zvalle

> Jaob satisfaction [jot = A0 C o o pERNOULLIG.R) =]
|A! Gender [gender]
5 Mumber of people i;l Contitue I Cancel | Help

Select Include if case satisfies condition.

Enter the conditional expression.

Most conditional expressions contain at least one relational operator, asin:

age>=21

or

income*3<100

In the first example, only cases with avalue of 21 or greater for Age (age) are
selected. In the second example, Household income in thousands (income) multiplied
by 3 must be less than 100 for a case to be selected.

You can aso link two or more conditional expressions using logical operators, asin:
age>=21 | ed>=4

or

income*3<100 & ed=5
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In the first example, cases that meet either the Age (age) condition or the Level of
education (ed) condition are selected. In the second example, both the Household
income in thousands (income) and Level of education (ed) conditions must be met for
a case to be selected.

Computing Variables with Missing Values

When computing variables with missing values, it's a good idea to perform atrial on
asmall datafilein order to ensure that your missing data is handled in away that
is acceptable. Some computations handle missing data by removing them from
the equation, while others cannot perform the computation and the new value is
considered missing. The following examples use car_sales.sav.

There are two different ways to compute the mean of a set of variables. Thefirstis
to divide the sum of the set of variables by the number of variablesin the set.

From the menus choose:

Transform
Compute...

» Type avgsale in the Target Variable text box.

» Type (resale + price) / 2 in the Numeric Expression text box.

Figure 9-10
Find the average

Target Y ariable: umeric E xpression:

Iavgsale = [rezale+price] / 2 d
Type&Label.. | J

[A] Marutacturer [man_ -

@Model [model] ;I ;ILI ﬂﬂi‘ Functions: E
gSales in thouzands | «=]>=] 4]|5]|5&] = 3
4-year resale value o= =] 1] 2] 3| |AMYtest value value,.. )
@ Wehicle type [type] _I _I_I _I_I_I ARSIM[numespr]
<#» Price in thousands Al o] gg;ﬁggﬁ?exﬁr] |
w| - zvalue
® Enagine zize [engine _I I [ I Delete COF.BERNOULLIg.p] j
@ Horsepower [horss
@W’heelbase [wabrzel ‘ IF.. | ‘

< idth [width]
4 Lenath llenathl ;I Qk Paste | Eesetl Cancell Help |
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This equation finds the average of the origina price of acar and its four-year resale
price.

» Click oK.

A new variable has been added to the end of the data file. This variable, which
we named avgsale, isin the far right column in Data View. Any cases that have
missing values in either of the two variables that we computed also have amissing
value for the avgsale variable.

Figure 9-11
Data Editor with avgsale added

SPSS Data Editor [ |O] x|

Eille Edit “iew Data Transform  Analyze  Graphs  Utilties  Window  Help

=|R|8| B| o|| D] =|k| @ Fre| BEES 2

|2D : |

zourh wy | zfuel ca Zmpg avgsale war yar var ﬂ
1 17212 -1.22223 97053 18.93

2 22042 - 15340 27004 2414
3 14587 -.19340 50353 .
4 74857 1237 -.43045 35.86
5 -B027 4 3997 73703 2312
B

7

g

29020 14097 -.43045 2875
83104 47844 -.BE395 50.50
- 31566 - 34772 52653 .
4 -287 1 - 34772 03654 31.04
10 14905 14097 22334 37.51
11 -01580 - 11624 27004 17.23
12 26166 - 11624 -. 19696 19.52
13 B3437 14097 03654 26.03
14 33779 - 11624 27004 2082

15 93158 14097 -.43045 31.21 -
1 [+ |\ Data view A Variable View [ <] | ol

—

The second way to compute the mean of a set of variablesis to use the mean function.
» Recall the Compute Variable dialog box.
» Click Reset to clear the previous selections in this dialog box.

» Type meansale in the Target Variable text box.
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» Type mean(resale, price) in the Numeric Expression text box.

Figure 9-12
Find the mean

Target Y ariable: umeric E xpression:
Imeansale = mean(resale. price] d
Type&Label.. |

[A] Marutacturer [man_ -

[8) Madel [madel] 2 el > ] 78] 8] Functions: E

gSales in thousands | <=l>=] 4]5]8] ABS[numexpr] 3
A-pear resale value === 1] 2| 3] [2Nvitestvaluevalue,...]

@ Wehicle type [type] j jj _ID_I_I ARSIM[numespr]

4 Price in thousands —I—I Eggﬁggﬁdﬁiﬁ{}e]

® Enagine zize [engine il _ I [ I Delete COF.BERMOULLI[g.p) j

@ Horsepower [horss

G Wheelbase [wheell ‘ LI ‘

< width [width]

4 Lenath llenathl ;I ak Pazte | Beset | Cancel | Help |

Like the previous example, this equation finds the average, or mean, of the car's
origina price and its four-year resale price.

» Click OK.
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The meansale variable is added to the far right column in Data View. Unlike the
previous example, the mean function removes missing values from the equation and
computes the mean of the remaining values. You can modify the behavior of this
function to limit the number of values that can be removed from the equation.

Figure 9-13
Results from two mean calculations

SPSS Data Editor - O] x|

File  Edit “iew Data Transform  Analwze  Graphs  Utlities  Window  Help

E=|S B o] o] =|k| @ ElE 2lEE S 2

|21 : |

zourh wy | zfuel ca Zmpg avgsale | meansale At WAL ﬂ
SIAT2 122223 7053 18.93 18.93

1

2 22042 - 18340 27004 2414 2414
3 14587 -.19340 .50353 . 18.23
4 74857 01237 -.43045 35.66 35.66
5 - 60274 3997 73703 2312 2312
]

i

g

29020 14097 -.43045 28.75 28.75

83104 1.47844 -.BE395 20.50 20.50

- 31566 - 34772 52655 . 26.99

4 - 28711 - 34772 03654 31.04 31.04
10 14905 14097 22334 37581 37581
11 -01590 - 11624 27004 17.23 17.23
12 26166 - 11624 - 15656 19.82 19.82

13 B34357 14097 03654 26.08 26.08
14 33779 - 11624 27004 20.62 20.62
15 95148 14097 -.43045 31.21 31.21 >

» I\Data\ﬂéw,(\rariame View [ 4] | o[




168

Chapter 9

If you want to find the mean of four variables and only want a result if three or more
of the variables have valid values, you could use the following syntax:

newvar = mean.3(varl, var2, var3, var4)

Figure 9-14
Specifying number of valid values for mean calculation

: Compute Yariable ﬂ

Target Wariable: Mumeric Exprezsion:
Inewvar = mean, Ivarl, var2, vard, vard] J
Typetlabel .. | J
@ M anufacturer [man -
&) Model [model] 2l <l | 7]8] 8] Functions:
gSales in thougands | ===l 4] 5] 8] AR rumexpr] 3
4-pear rezale value _I ;I_I _Iilil AN rest, value,value,...]
@ Yehicle type [type] ARSINInumexpr)
< Price in thousands —'JI il—l —I—I ’ég;ﬁggﬁ?ex?r] I
- zvalue
<# Engine size [engine 2 =1 0] _Delete || Fpp peRNOULLIG,0) R
® Haorsepower [harse
@ wheslbase [whesl LI
< Width [width]
5 Lenath Nenathl _I ak. Paste | Beset | Caticel | Help |

To raise or lower the number of required valid values, simply change the number
after mean (which is 3 in this example).
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Datafiles are not always organized in the ideal form for your specific needs. To
prepare data for analysis, you can select from awide range of file transformations,
including the ahility to:

m  Sort data. You can sort cases based on the value of one or more variables.

m  Select subsets of cases. You can restrict your analysis to a subset of cases or
perform simultaneous analyses on different subsets.

The examples in this chapter use the data file demo.sav.

Sorting Data

Sorting cases (sorting rows of the datafile) is often useful and sometimes necessary
for certain types of analysis.

To reorder the sequence of cases in the data file based on the value of one or
more sorting variables:

» From the menus choose:

Data
Sort Cases...

169
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This opens the Sort Cases dialog box.

Figure 10-1

Sort Cases dialog box
G Marital status [marit & Sort by:
4 Years at cunent ad @ Age in pears [age] - A
@ Income category in ’ Household income in b &l
@ Price of primary wet Reset |
& Primary vehicle !JIIE Sort Order —
G Level of education & Ascendin |
& Years with current | - .g Help |
# Retired [iatie] ;I Descending

» Addthe Agein years (age) and Household income in thousands (income) variables to
the Sort By list.

If you select multiple sort variables, the order in which they appear on the Sort By
list determines the order in which cases are sorted. In this example, based on the
entries in the Sort By list, cases will be sorted by the value of Household incomein
thousands (income) within categories of Age in years (age). For string variables,
uppercase letters precede their lowercase counterparts in sort order (for example, the
string value Yes comes before yes in the sort order).

Split-File Processing

To split your data file into separate groups for analysis:

» From the menus choose:

Data
Split File...
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This opens the Split File dialog box.

Figure 10-2
Split File dialog box

: 5plit File [ x|
G Years with curment .:I " Analyze all cases, do not create groups
& Job satistaction [job * —

. = ¢ Faste
& Number of people | " Orgahize output by groups
G Wireless service [n Groups Based an; Beset |
& Mu.ltlple Injes [mulll| @ Income category in tho Cermel |
@ Yoice mail [voice] E @ Gender [gender]
& Paging service [pa Help |
® Internet [internet]
@ Caller 1D [callid]
@ Call waiting [calwa % Sort the file by grouping variables
i Dwanz T Townby] LI ™ File is alrzady sorted

Current Status: Analvsiz by groups iz off.

Select Compare groups or Organize output by groups. The examples following these
steps show the differences between these two options.

Select Gender (gender) to split the file into separate groups for these variables.

You can use numeric, short string, and long string variables as grouping variables. A
separate analysisis performed for each subgroup defined by the grouping variables. If
you select multiple grouping variables, the order in which they appear on the Groups
Based On list determines the manner in which cases are grouped.
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If you select Compare groups and run the Frequencies procedure, a single pivot

table is created.
Figure 10-3
Split File output with single pivot table
Statistics
Household income inthousands
Female M Walid 37a
Missing i}
Mean BE.77498
Median 440000
Std. Deviation 7573510
hale ¥ Walid 3221
Missing 0
Mean 701608
Median 450000
Std. Deviation 81.896216

If you select Organize output by groups and run the Frequencies procedure, two pivot
tables are created: one for females and one for males.

Figure 10-4
Split File output with pivot table for females
Statistics®
Household income in thousands
M Walid 379
Missing i}
Mean BE.77498
Median 44.0000
Std. Deviation 7573510

a. Gender=Female
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Figure 10-5
Split File output with pivot table for males
Statistics®
Household income in thousands
M Walid 321
Missing 0
Mean TO608
Median 45.0000
Std. Deviation 81.56216

a. Gender= Male

Sorting Cases for Split-File Processing

The Split File procedure creates a new subgroup each time it encounters a different
value for one of the grouping variables. Therefore, it isimportant to sort cases based
on the values of the grouping variables before invoking split-file processing.

By default, Split File automatically sorts the data file based on the values of the
grouping variables. If thefileis already sorted in the proper order, you can save
processing time if you select File is already sorted.

Turning Split-File Processing On and Off

Once you invoke split-file processing, it remains in effect for the rest of the session
unless you turn it off.

®m  Analyze all cases. Turns split-file processing off.
m  Compare groups and Organize output by groups. Turns split-file processing on.

If split-file processing is in effect, the message Split File on appears on the status bar at
the bottom of the application window.
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Selecting Subsets of Cases

You can restrict your analysis to a specific subgroup based on criteria that include
variables and complex expressions. You can also select a random sample of cases.
The criteria used to define a subgroup can include:

Variable values and ranges
Date and time ranges
Case (row) numbers
Arithmetic expressions
Logical expressions

Functions

To select a subset of casesfor analysis:
» From the menus choose:

Data
Select Cases...

This opens the Select Cases dialog box.

Figure 10-6
Select Cases dialog box
el
4 hge in years [age] =+ e
& Marital status [marit & Allcases
B Years ot cument ad £ IF condition is satisfied
< Household income If |

B Income category in " Random sample of cases

@ Price of primary vel e

& Primary vehicle pric _Ia'"Fl c

% Level af education " Based on time ar case 1ange
4 Years with curent « Fange,.. |

& Retired [retire]

© Use filter variable:
@ Years with cunent .

@ Jab satisfaction fjot —
4 Number of peaple i

@Wue\ess servics [m Unselected Cases Ar

& Mulliple lines [mult = ’7(" Filtered ) Deleted

Current Status: Do not filker cases

ok | Paste | F\asatl Eam:a\l Help |
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Selecting Cases Based on Conditional Expressions

To select cases based on a conditional expression:

Select If condition is satisfied and click If in the Select Cases dialog box.

This opens the Select Cases If dialog box.

Figure 10-7

Select Cases If dialog box

Select Cazes: If [ x|
& Age in pears [age] |~ ;I
@ Marital status [marit
4 Years at cunent ad =l
G Household income :
& Income categon in | <15 | 7]8]|3]| Functions: E
® PUCB of primary V?} | =le=] 415]8] AB S [humexpr) il
# Primary vehicle pric =] =0 1] 2)3] ANY[test,value, value,...)

# Level of education
G Years with current
< Retired [retire]

& Years with current
@ Job zatisfaction [iolﬂ

A S N I
il LI_UJ Delete |

Eontinuel Cancel |

ARSI [rumespr)
ARTAM[numespr]
COFMORK[zvalue)
COF.BERMOULLIG.R)

Help |

|

The conditional expression can use existing variable names, constants, arithmetic
operators, logical operators, relational operators, and functions. You can type and edit
the expression in the text box just like text in an output window. You can aso use the
calculator pad, variable list, and function list to paste elements into the expression.
For moreinformation, see “Using Conditional Expressions’ in Chapter 9 on page 162.

Selecting a Random Sample

To obtain a random sample:
» Select Random sample of cases in the Select Cases dialog box.

» Click sample.

This opens the Select Cases Random Sample dialog box.
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Figure 10-8
Select Cases Random Sample dialog box

: Select Cazes: Random Sample n

Sample Size

%" Approwimately I % of all cases

. Exactlyl cazes from the first I casesl
Eontinuel Catcel | Help |

You can select one of the following aternatives for sample size:

m  Approximately. A user-specified percentage. This option generates a random
sample of approximately the specified percentage of cases.

m  Exactly. A user-specified number of cases. You must also specify the number of
cases from which to generate the sample. This second number should be less
than or equal to the total number of casesin the datafile. If the number exceeds
the total number of cases in the data file, the sample will contain proportionally
fewer cases than the requested number.

Selecting a Time Range or Case Range
To select arange of cases based on dates, times, or observation (row) numbers:
» Select Based on time or case range and click Range in the Select Cases dialog box.

This opens the Select Cases Range dialog box, in which you can select arange
of observation (row) numbers.



177

Sorting and Selecting Data

Figure 10-9
Select Cases Range dialog box

First Caze  Last Case Continue I
Observation: I I Cancel |
Help |

m  First Case. Enter the starting date and/or time values for the range. If no date
variables are defined, enter the starting observation number (row number in the
Data Editor, unless Split Fileis on). If you do not specify aLast Case value, al
cases from the starting date/time to the end of the time series are sel ected.

m Last Case. Enter the ending date and/or time values for the range. If no date
variables are defined, enter the ending observation number (row number in the
Data Editor, unless Split Fileis on). If you do not specify aFirst Case value, al
cases from the beginning of the time series up to the ending date/time are selected.

For time series data with defined date variables, you can select arange of dates and/or
times based on the defined date variables. Each case represents observations at a
different time, and the file is sorted in chronological order.

Figure 10-10
Select Cases Range dialog box (time series)

i Select Cases: Hange m
First Caze  Last Case e I

sk I I Cancel
Day: I I Tlpl
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To generate date variables for time series data:

» From the menus choose:

Data
Define Dates...

Unselected Cases

You can choose one of the following aternatives for the treatment of unselected cases:

m Filtered. Unselected cases are not included in the analysis but remain in the data
file. You can use the unselected cases later in the session if you turn filtering
off. If you select arandom sample or if you select cases based on a conditional
expression, this generates a variable named filter_$ with avalue of 1 for selected
cases and a value of 0 for unselected cases.

m Deleted. Unselected cases are deleted from the datafile. By reducing the number
of casesin the open data file, you can save processing time. Deleted cases can
be recovered only by exiting from the file without saving any changes and then
reopening the file. The deletion of casesis permanent if you save the changes
to the datafile. Note: If you delete unselected cases and save the file, the cases
cannot be recovered.

Case Selection Status

If you have selected a subset of cases but have not discarded unselected cases,
unselected cases are marked in the Data Editor with a diagonal line through the
row number.
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Figure 10-11
Case selection status
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Chapter

Additional Statistical Procedures

This chapter contains brief examples for selected statistical procedures. The
procedures are grouped according to the order in which they appear on the Analyze
menul.

The examples are designed to illustrate sample specifications required to run a
statistical procedure. The examplesin this chapter use the data file demo.sav, except
for the following:

m The paired-samplest test example uses the data file dietstudy.sav, which isa
hypothetical datafile containing the results of a study of the “ Stillman diet.” In
the examples in this chapter, you must run the procedures to see the output.

m  The correlation examples use Employee data.sav, which contains historical
data about a company's employees.

m  The exponential smoothing example uses the data file inventor.sav, which
contains inventory data collected over a period of 70 days.

For information about individual itemsin a dialog box, click Help. If you want to
locate a specific statistic, such as percentiles, use the Index or Search facility in the

Help system. For additional information about interpreting the results obtained by
running these procedures, consult a statistics or data analysis textbook.

Summarizing Data

The Descriptive Statistics submenu on the Analyze menu provides techniques for
summarizing data with statistics and charts.
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Frequencies

In the chapter Examining Summary Statistics for Individual Variables, thereis an
example showing afrequency table and a bar chart. In that example, the Frequencies
procedure was used to analyze the variables Owns PDA (ownpda) and Owns TV
(owntv), both of which are categorical variables having only two values. If the
variable that you want to analyze is a scale (interval, ratio) variable, you can use the
Freguencies procedure to generate summary statistics and a histogram. A histogram
isachart that shows the number of cases in each of severa groups. This example will
use Frequencies to analyze the variable Years with current employer (employ).

To generate statistics and a histogram of the years with current employer, follow

these steps:

» From the menus choose:

Analyze

Descriptive Statistics

Frequencies...

This opens the Frequencies dialog box.

Figure 11-1

Frequencies dialog box

@ Age in years [age] &~
> Marital stabus [marit
& Years at cument a

G Household income

& Income category in
® Price of primary et
@ Primary vehicle pric

& Level of educationll

e Y R A T

" Display frequency tables

Y ariable(z):

0
& Years with curent empl

Paste
Reset

Cancel

iz A

Help

Statistics... | Chartz... | Farmat... |

» Select Yearswith current employer (employ) and move it to the Variable(s) list.
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» Desdect the Display frequency tables check box.

(If you leave this item selected and display a frequency table for current salary, the
output shows an entry for every distinct value of salary, making a very long table.)

» Click Charts to open the Freguencies Charts dialog box.

Figure 11-2
Frequencies Charts dialog box
Frequencies: Charts m
— Chart Type
[l
e Cancel |
" Bar charts
" Pie charts ﬂl
& Histograms
i~ With normal curve

= Chart Values

% Frequencies € Percentages

» Select Histograms and With normal curve, and then click Continue.

» To select summary statistics, click Statistics in the Frequencies dialog box. This
displays the Frequencies Statistics dialog box.
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Figure 11-3
Frequencies Statistics dialog box
Frequencies: Statistics [ x|
— Percentile ¥alues r— Central Tendency
I Quartiles ¥ Mean Cancel |
I Cut points fol:I'IU equal groups [~ Median Help |
r Percentile[s]:l [ Mode
Add [~ Sum
Change
m [~ Walues are group midpaints
— Dizpersion — Distribution
[ Std. devistion [ Minimum [~ Skewness
I~ “aniance ¥ taximum W [
[ Range [" S.E. mean

» Select Mean, Std. deviation, and Maximum, and then click Continue.

» Click oK in the Frequencies dialog box to run the procedure.

The Viewer shows the requested statistics and a histogram in standard graphics
format. Each bar in the histogram represents the number of employees within arange
of five years, and the year values displayed are the range midpoints. Asrequested, a
normal curve is superimposed on the chart.

Explore

Suppose that you want to look further at the distribution of the years with current
employer for each income category. With the Explore procedure, you can examine the
distribution of the years with current employer within categories of another variable.
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» From the menus choose:

Analyze
Descriptive Statistics
Explore...

Additional Statistical Procedures

This opens the Explore dialog box.

Figure 11-4
Explore dialog box

@ Age inyears [age] ~
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Paste

Rezet

Factor List:
Cancel

’ Income categom in the

Help

elilzle|

Label Cazes by:

Statistics...l Plots... | Dptions...l

Select Years with current employer (employ) and move it to the Dependent List.
Select Income category in thousands (inccat) and move it to the Factor List.

Click OK to run the Explore procedure.

In the output, descriptive statistics and a stem-and-leaf plot are displayed for the years
with current employer in each income category. The Viewer aso contains a boxplot
(in standard graphics format) comparing the years with current employer in the
income categories. For each category, the boxplot shows the median, interquartile
range (25th to 75th percentile), outliers (indicated by O), and extreme values

(indicated by *).
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More about Summarizing Data

There are many ways to summarize data. For example, to calculate medians or
percentiles, use the Frequencies procedure or the Explore procedure. Here are some
additional methods:

m Descriptives. For income, you can calculate standard scores, sometimes called
z scores. Use the Descriptives procedure and select Save standardized values
as variables.

m  Crosstabs. You can use the Crosstabs procedure to display the relationship
between two or more categorical variables.

m  Summarize procedure. YOU can use the Summarize procedure to write to your
output window alisting of the actual values of age, gender, and income of the
first 25 or 50 cases. To run the Summarize procedure, from the menus choose:

Analyze
Reports
Case Summaries...

Comparing Means

The Compare Means submenu on the Analyze menu provides techniques for
displaying descriptive statistics and testing whether differences are significant
between two means for both independent and paired samples. You can aso test
whether differences are significant among more than two independent means by
using the One-Way ANOVA procedure.
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In the demo.sav file, several variables are available for dividing people into groups.
You can then calculate various statistics in order to compare the groups. For example,
you can compute the average (mean) household income for males and females. To
calculate the means, use the following steps:

From the menus choose:

Analyze
Compare Means
Means...

This opens the Means dialog box.

Figure 11-5
Means dialog box (layer 1)

4 Primany vehicle pric;l Dependent List: K.

H
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& Mumber of people i él ;I Help

® Wireless service [w Independent List:
& Multiple lines [multi [ Gender |
@ Yoice mail [woice] E

& Paging service [DaLI

gender]

sl

Options. ..

» Select Household income in thousands (income) and move it to the Dependent List.

» Select Gender (gender) and move it to the Independent List in layer 1.

» Click Next. This creates another layer.
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Figure 11-6
Means dialog box (layer 2)
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Options. ..
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» Select Owns PDA (ownpda) and move it to the Independent List in layer 2.

» Click OK to run the procedure.

Paired-Samples T Test

When the data are structured in such away that there are two observations on

the same individual or observations that are matched by another variable on two
individuals (twins, for example), the samples are paired. In the datafile dietstudy.sav,
the beginning and final weights are provided for each person who participated in the
study. If the diet worked, we expect that the participant's weight before and after the
study would be significantly different.

To carry out at test of the beginning and final weights, use the following steps:

» Open the data file dietstudy.sav, which can be found in the \tutorial\sample_files\
subdirectory of the directory in which you installed SPSS.
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» From the menus choose:

Analyze
Compare Means
Paired-Samples T Test...

This opens the Paired-Samples T Test dialog box.

Figure 11-7

Paired-Samples T Test dialog box
i Paired-5amples T Test E
@ Patient ID [patid] |+ Paired ¥/ ariables: oK
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— Current Selections
Wariable 1:
Wariable 2:

Cancel

Help

el

» Click Weight (wgt0). The variableis displayed in the Current Selections group (below
the variable list).

» Click Final weight (wgt4). The variableis displayed in the Current Selections group.
» Click the arrow button to move the pair to the Paired Variables list.

» Click OK to run the procedure. If there are rows of asterisks in some columns,
double-click the chart and drag to make the columns wider.

The results show that the final weight is significantly different from the beginning
weight, asindicated by the small probability displayed in the Sg. (2-tailed) column
of the Paired Samples Test table.

More about Comparing Means

The following examples suggest some ways in which you can use other procedures to
compare means.
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®m Independent-Samples T Test. When you use at test to compare means of one
variable across independent groups, the samples are independent. Males and
females in the demo.sav file can be divided into independent groups by the
variable Gender (gender). You can use at test to determine if the mean household
incomes of males and females are the same.

m  One-Sample T Test. You can test whether the household income of people with
college degrees differs from a national or state average. Use Select Cases on the
Data menu to select the cases with Level of Education (ed) >= 4. Then, run
the One-Sample T Test procedure to compare Household income in thousands
(income) and the test value 75.

m  One-Way ANOVA. The variable Level of Education (ed) divides employeesinto five
independent groups by level of education. You can use the One-Way ANOVA
procedure to test whether Household income in thousands (income) means for the
five groups are significantly different.

ANOVA Models

The General Linear Model submenu on the Analyze menu provides techniques for
testing univariate analysis-of-variance models. (If you have only one factor, you can
use the One-Way ANOVA procedure on the Compare Means submenu.)

Univariate Analysis of Variance

The GLM Univariate procedure can perform an analysis of variance for factoria
designs. A simple factoria design can be used to test if a person’'s household income
and job satisfaction affect the number of years with current employer.
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» From the menus choose:

Analyze
General Linear Model
Univariate...

This opens the Univariate dialog box.

Figure 11-8
Univariate dialog box

@ Age in years [age] 4 Dependent Yariable: Model..
> Marital status [marit I@ “rears with curent emp

& Years at curent ad Fixed Factor(s) Contrasts...
& Househald income r

- . | t i~ Plats...
® Price of primary wet @ Income category |n_|

& Primary vehicle pric > Job satisfaction [IDtLI Post Hoo..
& Level of education Bt st
@ Retired [retire] Save...

dilddl;

G Years with current :
— Options...

E Gender [gender]
& Number of people i

A Wireless service [w

4 Multiple: lines [rmult
& Voice mail [voice]

@ Paging service [par

& Intemnet [intemet] LI i\'_\;LSWEight
ak. I Eastel Eesell Cancell Help |

LCovariate(s]:

» Select Yearswith current employer (employ) as the dependent variable.

» Select Income category in thousands (inccat) and Job satisfaction (jobsat) as fixed
factors.

» Click OK to run the procedure.

In the Tests of Between-Subjects Effects table, you can see that the effects of income
and job satisfaction are definitely significant and that the observed significance level
of the interaction of income and job satisfaction is 0.000. For further interpretation,
consult a statistics or data analysis textbook.
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Correlating Variables

The Correlate submenu on the Analyze menu provides measures of association for
two or more numeric variables.
The examplesin this topic use the data file Employee data.sav.

Bivariate Correlations

The Bivariate Correlations procedure computes statistics such as Pearson's correlation
coefficient. Correlations measure how variables or rank orders arerelated. Correlation
coefficients range in value from —1 (a perfect negative relationship) and +1 (a perfect
positive relationship). A value of 0 indicates no linear relationship.

For example, you can use Pearson's correl ation coefficient to see if there isa strong
linear association between Current Salary (salary) and Beginning Salary (salbegin) in
the data file Employee data.sav.

Partial Correlations

>

The Partial Correlations procedure calculates partial correlation coefficients that
describe the relationship between two variables while adjusting for the effects of one
or more additional variables.

You can estimate the correlation between Current Salary (salary) and Beginning
Salary (salbegin), controlling for the linear effects of Months since Hire (jobtime)
and Previous Experience (prevexp). The number of control variables determines the
order of the partial correlation coefficient.

To carry out this Partial Correlations procedure, use the following steps:

Open the Employee data.sav file. Itisusually in the directory where SPSSisinstalled.
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» From the menus choose:

Analyze
Correlate
Partial...

This opens the Partial Correlations dialog box.

Figure 11-9
Partial Correlations dialog box
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» Select Current Salary (salary) and Beginning Salary (salbegin) and move them to
the Variables list.

» Select Months since Hire (jobtime) and Previous Experience (prevexp) and move
them to the Controlling For list.

» Click OK to run the procedure.

The output shows atable of partial correlation coefficients, the degrees of freedom,
and the significance level for the pair Current Salary (salary) and Beginning Salary
(salbegin).

Regression Analysis

The Regression submenu on the Analyze menu provides regression techniques.
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Linear Regression

The Linear Regression procedure examines the relationship between a dependent
variable and a set of independent variables. You can use it to predict a person's
household income (the dependent variable) from independent variables such as age,
number in household, and years with employer.

» From the menus choose:

Analyze
Regression
Linear...

This opens the Linear Regression dialog box.

Figure 11-10
Linear Regression dialog box
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» Select Household income in thousands (income) and move it to the Dependent list.

» Select Agein years (age), Number of people in household (reside), and Years with
current employer (employ) and move them to the Independent(s) list.

» Click OK to run the procedure.
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The output contains goodness-of -fit statistics and the partial regression coefficients
for the variables.

Examining fit. To see how well the regression model fits your data, you can examine
the residuals and other types of diagnostics that this procedure provides. In the Linear
Regression dialog box, click Save to see alist of the new variables that you can add to
your datafile. If you generate any of these variables, they will not be availablein a
later session unless you save the datafile.

Methods. If you have collected a large number of independent variables and want to
build aregression model that includes only variablesthat are statistically related to the
dependent variable, you can select a method from the drop-down list. For example, if
you select Stepwise in the above example, only variables that meet the criteriain the
Linear Regression Options dialog box are entered in the equation.

Nonparametric Tests

The Nonparametric Tests submenu on the Analyze menu provides nonparametric tests
for one sample or for two or more paired or independent samples. Nonparametric
tests do not require assumptions about the shape of the distributions from which

the data originate.

Chi-Square

The Chi-Square Test procedure is used to test hypotheses about the relative proportion
of casesfaling into several mutually exclusive groups. You can test the hypothesis
that people who participated in the survey occur in the same proportions of gender
as the general population (50% males, 50% females).

In this example, you will need to recode the string variable Gender (gender) into
anumeric variable before you can run the procedure.
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» From the menus choose:

Transform

Automatic Recode.

This opens the Automatic Recode dialog box.
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Cancel

Help

Figure 11-11

Automatic Recode dialog box
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» Select the variable Gender (gender) and move it to the Variable -> New Name list.

» Typegender2 in the New Name text box, and then click the New Name button.

» Click OK to run the procedure.

This creates anew numeric variable called gender2, which has avalue of 1 for females
and avalue of 2 for males. Now a chi-square test can be run with a numeric variable.

» From the menus choose:

Analyze

Nonparametric Tests

Chi-Square...

» This opens the Chi-Square Test dialog box.
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Figure 11-12
Chi-Square Test dialog box
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» Select Gender (gender?2) as the test variable.

» Select All categories equal, since, in the general population of working age, the number
of males and females is approximately equal.

» Click OK to run the procedure.

The output shows a table of the expected and residual values for the categories. The
significance of the chi-square test is 0.6. Consult a statistics or data analysis text book
for more information on interpretation of the statistics.

Time Series Analysis

A time series variable is a variable whose values are recorded at regular intervals
over aperiod of time. The Time Series submenu on the Analyze menu provides
exponential smoothing that can be used for predictions. Exponential Smoothing is
available in the Student Version and in the Trends module.
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Exponential Smoothing

The Exponential Smoothing procedure performs exponential smoothing of time
series data. It creates new series containing predicted values and residuals. This
topic uses the Inventor.sav file.

For example, you can fit amodel for inventory data and use it to predict the next
week's inventory. Suppose that for 70 days you have kept track of the inventory of
power supplies and that you want to construct a model and then use it to forecast
power supplies for the next week.

To use the Exponential Smoothing procedure to forecast power supplies, follow
these steps:

» Open the Inventor.sav file. It isusually in the directory where SPSSisinstalled.

» From the menus choose:

Analyze
Time Series
Exponential Smoothing...

This opens the Exponential Smoothing dialog box.

Figure 11-13
Exponential Smoothing dialog box
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» Select Number of power supplies (amount) and move it to the Variables list.
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» Click Parameters to specify the procedure.

This opens the Exponential Smoothing Parameters dialog box

Figure 11-14

Exponential Smoothing Parameters dialog box
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» To search for the best general parameter, select Grid Search and then click Continue.

» To create anew variable that contains predicted values, click Save.

This opens the Exponential Smoothing Save dialog box.

Figure 11-15
Exponential Smoothing Save dialog box
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>

>

>

>

Select Predict through and type 77 in the Observation text box.
This adds 7 days to the original 70.

Click Continue and then in the main dialog box, click OK.

This runs the procedure and adds the new variablesfit_1 and err_1. The variablefit_1
contains the fitted values and the seven new predicted values. The variable err_1
contains residual values for the original 70 cases; you can use the residuals for further
analysis. If you want to save the new variables, select Save As from the File menu
and save the data file under a new name.

To see achart of the original data and the new fit line, from the menus choose:

Graphs
Sequence...

This opens the Sequence Charts dialog box.

Figure 11-16
Sequence Charts dialog box
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Select Number of power supplies (amount) and Fit for AMOUNT (fit_1) and move
them to the Variables list.

Click OK to run the procedure.
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The resulting chart shows both the actual number of power supplies and thefit line
plotted on the same axes. The predicted values are plotted for the next week on the
right side of the chart.
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reuse, 66
value labels
assigning, 58, 60
controlling display in Viewer, 58, 60
non-numeric variables, 60
numeric variables, 58
variable labels
creating, 56
variables, 51
data types, 57
labels, 56
Viewer
hiding and showing output, 89
moving output, 89

Word (Microsoft)
exporting results to, 117
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